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T A B L E  O F  
C O N T E N T S

S O M M A I R E Í N D I C E Ü B E R B L I C K

S P O R T S E R IE S	 8
>	 SP O R T 1 9 0	 1 0

S P X S E R IE S	 1 4
>	 SP X 1 9 0 O B	 1 6 
> 	 SP X 1 9 0 	 2 0
>	 SP X 2 1 0	 24
>	 SP X 2 3 0	 2 2

S L X S E R IE S	 3 2
>	 SL X 2 5 0	 3 4

S DX S E R IE S	 3 8
>	 SDX 2 7 0	 4 0

S U N S P O R T S E R IE S	 4 4
>	 S UN SP O R T 2 3 0	 4 6
>	 S UN SP O R T 2 5 0	 5 0

S U N D A N C E R S E R IE S	 5 4
>	 S UND A N C E R 2 65	 5 6
>	 S UND A N C E R 3 2 0	 6 2
>	 S UND A N C E R 35 5	 6 8

FA R B E N F Ü R 	 74 
GE L B E S C HI C H T U N G		

P O L S T E R 	 7 6  			

E I GE N S C H A F T E N U N D 	 7 8  
O P T I O N E N S P O R T B O O T E

E I GE N S C H A F T E N U N D 	 8 0
O P T I O N E N S P O R T C RU IS E R

T E C H NIS C H E A N G A B E N 	 8 2

S E A R AY L IN E U P  	 9 4

S P O R T S E R IE S	 8
>	 SP O R T 1 9 0	 1 0

S P X S E R IE S	 1 4
>	 SP X 1 9 0 O B	 1 6 
> 	 SP X 1 9 0 	 2 0
>	 SP X 2 1 0	 24
>	 SP X 2 3 0	 2 8

S L X S E R IE S	 3 2
>	 SL X 2 5 0	 3 4

S DX S E R IE S	 3 8
>	 SDX 2 7 0	 4 0

S U N S P O R T S E R IE S	 4 4
>	 S UN SP O R T 2 3 0	 4 6
>	 S UN SP O R T 2 5 0	 5 0

S U N D A N C E R S E R IE S	 5 4
>	 S UND A N C E R 2 65	 5 6
>	 S UND A N C E R 3 2 0	 6 2
>	 S UND A N C E R 35 5	 6 8

C O L O R E S D E L O S 	 74 
R E V E S T IMIE N T O S D E GE L 	

TA P I C E R Í A 	 7 6

C A R A C T E R ÍS T I C A S Y 	 7 8 
O P C I O N E S  E M B A RC A C I O N E S  
D E P O R T I VA S 				 

C A R A C T E R ÍS T I C A S Y 	 8 0 
O P C I O N E S  C RU C E RO S  
D E P O R T I V O S

E S P E C IF I C A C I O N E S  	 8 2
		
G A M A S E A R AY 	 9 4

S P O R T S E R IE S	 8
>	 SP O R T 1 9 0	 1 0

S P X S E R IE S	 1 4
>	 SP X 1 9 0 O B	 1 6 
> 	 SP X 1 9 0 	 2 0
>	 SP X 2 1 0	 24
>	 SP X 2 3 0	 2 8

S L X S E R IE S	 3 2
>	 SL X 2 5 0	 3 4

S DX S E R IE S	 3 8
>	 SDX 2 7 0	 4 0

S U N S P O R T S E R IE S	 4 4
>	 S UN SP O R T 2 3 0	 4 6
>	 S UN SP O R T 2 5 0	 5 0

S U N D A N C E R S E R IE S	 5 4
>	 S UND A N C E R 2 65	 5 6
>	 S UND A N C E R 3 2 0	 6 2
>	 S UND A N C E R 35 5	 6 8

C O U L E U R S E T V IS U E L S 	 74  
P O U R C O U C H E GE L C O AT 	

S E L L E R IE S 	 7 6

F O N C T I O N N A L I T É S E T 	 7 8  
O P T I O N S S P O R T B O AT S 	

F O N C T I O N N A L I T É S E T 	 8 0 
O P T I O N S S P O R T C RU IS E R S 				 

S P É C IF I C AT I O N S 	 8 2

G A M M E S E A R AY 	 9 4

S P O R T S E R IE S	 8
>	 SP O R T 1 9 0	 1 0

S P X S E R IE S	 1 4
>	 SP X 1 9 0 O B	 1 6 
> 	 SP X 1 9 0 	 2 0
>	 SP X 2 1 0 	 24
>	 SP X 2 3 0	 2 8

S L X S E R IE S	 3 2
>	 SL X 2 5 0	 3 4

S DX S E R IE S	 3 8
>	 SDX 2 7 0	 4 0

S U N S P O R T S E R IE S	 4 4
>	 S UN SP O R T 2 3 0	 4 6
>	 S UN SP O R T 2 5 0	 5 0

S U N D A N C E R S E R IE S	 5 4
>	 S UND A N C E R 2 65	 5 6
>	 S UND A N C E R 3 2 0	 6 2
>	 S UND A N C E R 35 5	 6 8

GE L C O AT C O L O R S	 74

U P H O L S T E RY	 7 6

F E AT U R E S & O P T I O N S	 7 8
S P O R T B O AT S

F E AT U R E S & O P T I O N S	 8 0
S P O R T C RU IS E R S

S P E C IF I C AT I O N S	 8 2

S E A R AY L IN E U P	 9 4

32



5

D E F I N E  Y O U R  L I F E  W I T H  
T H E  M O M E N T S  T H A T  C O U N T

F A I T E S  D E  V O T R E  V I E  
U N E  S U C C E S S I O N  

D E  M O M E N T S  I M P O R T A N T S

D É  S E N T I D O  A  S U  V I D A  
C O N  M O M E N T O S  V A L I O S O S

S C H A F F E N  S I E  S I C H  I H R E  
W E R T V O L L E N  A U G E N B L I C K E  

I M  L E B E N
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W E  B U I L D  S O M E T H I N G  E L S E
Sea Rays aren’t built simply to get you out on the water. No—we take pride in delivering something 

else. Have you ever smiled head to toe? Better yet, has your family? We build boats, yes, but with each 
dash we sculpt and each hull we craft, we build a lifestyle that will redefine your meaning of happy. 
Experience the better boating that Sea Ray imagines and then makes real. Evaluate the audacity of 
our vision, scrutinize every facet of our craftsmanship and savor the richness of our finishes. Feel the 
embrace of the Sea Ray community and the comfort of our world-class support systems. Add it up. 

That’s something more than simply boating. That’s something else altogether.

L A  D I F F É R E N C E  S E A  R A Y
Sea Ray ne se contente pas de vous emmener sur l’eau. Nos bateaux font mieux. est ce que vous êtes 

heureux ? et votre famille ? Nous construisons des bateaux, c’est indéniable ! Mais chacun de nos 
design, chacune de nos coques donne vie à un style de navigation qui va changer à jamais votre vision 

du bonheur. Venez goûter à la navigation imaginée par Sea Ray. Testez l’audace de notre vision, scrutez 
chaque facette de notre savoir-faire et goûtez à la richesse de nos finitions. Ressentez l’état d’esprit de 
la communauté Sea Ray autour de vous et testez le confort de nos bateaux haut de gamme. La somme 
de tous ces bienfaits va bien au-delà de la simple navigation. Bienvenue dans une nouvelle dimension.

C O N S T R U I M O S  A L G O  B I E N  D I S T I N T O
Las embarcaciones de Sea Ray no se han construido solo para salir a navegar. Al contrario, nos 

enorgullece ofrecerle algo más. ¿Cuándo fue la última vez que no pudo dejar de sonreír? O mejor aún, 
¿cuándo lo hizo su familia? Es verdad que construimos embarcaciones, pero con cada tablero que 
tallamos y cada casco que fabricamos, creamos un estilo de vida que dará un significado nuevo al 

concepto de felicidad. Disfrute de la mejor navegación ingeniada por Sea Ray. Compruebe la audacia 
de nuestra visión, estudie cada faceta de nuestra artesanía y admire la riqueza de nuestros acabados. 

Disfrute del respaldo de la comunidad Sea Ray y del confort de nuestros servicios de primera categoría. 
Si hace la suma, verá que no nos limitamos a vender embarcaciones, sino que ofrecemos algo bien 

distinto.

W I R  B A U E N  D A S  B E S O N D E R E
Sea Rays werden nicht einfach gebaut, um Sie auf das Wasser hinauszubringen. Vielmehr sind wir 

stolz darauf, Ihnen etwas Besonderes bieten zu können. Haben Sie schon einmal wirklich voller innerer 
Zufriedenheit gelächelt? Besser noch, hat Ihre Familie jemals so gestrahlt? Wir bauen Boote, ja. Aber 
mit jedem unserer Schritte modellieren wir und mit jedem Rumpf gestalten wir - wir schaffen einen 

Lebensstil, der die Bedeutung von Glück neu definieren wird. Erleben Sie das einzigartige Bootsgefühl, 
das Sea Ray konzipiert und dann Wirklichkeit werden lässt. Beurteilen Sie den Wagemut unserer Vision, 

prüfen Sie jede Facette unserer Handwerkskunst und genießen Sie die hochwertige Verarbeitung. 
Lassen Sie sich von der Sea Ray Gemeinschaft tragen und überzeugen Sie sich von dem Komfort 

unserer erstklassigen Support-Systeme. Und alles zusammen ist mehr als die Summe der einzelnen 
Teile! Es ist mehr als einfaches Bootfahren. Es ist insgesamt etwas ganz Besonderes.
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SERIES
SPORT

S P O R T
S E R I E S

For sporting enthusiasts who refuse to sacrifice style for 
affordability, who demand high performance matched by ease of 
use, the Sport series makes boating enjoyable by making the Sea 

Ray lifestyle accessible.
 

Destinée aux fans de sport qui refusent de sacrifier l’élégance à 
des critères financiers et qui veulent combiner performances et 

facilité d’utilisation, la série Sport fait de la navigation un plaisir 
extrême en mettant le style Sea Ray à la portée de tous.

Para deportistas fanáticos que se niegan a sacrificar estilo por 
asequibilidad, que desean un gran rendimiento, así como una 

facilidad de uso, la serie Sport permite disfrutar de la navegación 
poniendo el estilo de vida Sea Ray al alcance de todos.

Für Sportbegeisterte, die sich weigern, wegen erschwinglicherer 
Preise beim Styling Abstriche zu machen und die eine hohe 

Leistung bei entsprechend guter Bedienbarkeit verlangen, macht 
die Sport-Serie Bootsausflüge zu einem echten Genuss, denn sie 

macht den Sea Ray Lifestyle auch für sie zugänglich.

9
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FEATURES

>> Sleek design, low-profile windshield

>> Gull-wing sun pad

>> Stainless steel three step swimladder 

CARACTÉRISTIQUES

>> 2 sièges baquets avec coussinets relevables Grand bain 
de soleil

>> Bain de soleil avec ouverture centrale bâbord intégrée

>> De bain à trois marches en acier inoxydable et poignée 
intégrée 

CARACTERÍSTICAS

>> Asientos giratorios

>> Solárium con paso de acceso a espejo de popa

>> De baño de acero inoxidable de tres peldaños y asidero 

EIGENSCHAFTEN

>> Schalensitze (2) mit hochklappbaren Schenkelpolstern

>> Sonnenliege mit integriertem Heck-Durchgang

>> Badeleiter aus Edelstahl und Haltegriff

S E A  R A Y
S P O R T ®  1 9 0

1 0
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098 L

7 P / 545 KG

1.179 KG

5,99 M | 2,21 M

FEATURES

>> Optional water sport tower 

>> Full beam sun pad

>> Extended Swim platform 

CARACTÉRISTIQUES

>> Tour de sports nautiques en option

>> Grand bain de soleil

>> Plate-forme de bain XXL 

CARACTERÍSTICAS

>> Torre opcional para deportes acuáticos

>> Solárium que abarca toda la manga

>> Plataforma de baño extendida 

EIGENSCHAFTEN

>> Optionaler Wassersportturm

>> Sonnenliege über die gesamte Breite

>> Verlängerte Badeplattform

S E A  R A Y
S P O R T ®  1 9 0
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Every once in a while, we need to simplify in order to grow.
Sea Ray’s all-new SPX series is just that our idea of what the 

sport boating experience should be. An edgy, sporty design and 
compelling performance combine to deliver the spirit of Sea Ray in 
an accessible, sleek package. Available in sterndrive and outboard 

with convertible seating and convenient options packages, 
any SPX will become your SPX. 

Il est parfois bon de simplifier les choses pour avancer.  
C’est ce qu’a fait Sea Ray avec la toute nouvelle série SPX,  

en imaginean de ce que le nautisme devrait être. Design sportif 
simple et performances exceptionnelles se combinent  

pour offrir un style unique, conforme à l’esprit de  
Sea Ray. Disponible en version moteur iboard  ou hors-bord,  

avec sièges convertibles et kits d’options pratiques,  
le SPX deviendra vite votre SPX.

De vez en cuando, tenemos que dejar de complicar las cosas  
para poder crecer. La serie SPX totalmente renovada de Sea Ray  

es precisamente el resultado de eso, la idea de lo que una 
experiencia en una embarcación deportiva debería ser.  
La combinación de un diseño deportivo y atrevido y un 

rendimiento óptimo recopila el espíritu de Sea Ray en un paquete 
elegante y accesible. Disponible en motor de popa o fueraborda 

con asientos convertibles y cómodos paquetes de opciones, 
cualquier SPX se convertirá en su SPX.

Hin und wieder müssen wir Dinge vereinfachen, um voran  
zu kommen. Genau dies ist die neue SPX-Serie von Sea Ray -  

der Inbegriff dessen, was ein Sportboot sein sollte. Das angesagte 
sportliche Design und überzeugende Leistungen verwirklichen 

den Geist von Sea Ray in einem durchaus erschwinglichen 
und ansprechend ausgestatteten Boot. Mit Heckantrieb und 
Außenbordmotor, mit umklappbaren Sitzen und praktischen 

Optionen wird jedes SPX im Handumdrehen Ihr persönliches SPX.

SERIES
SPX

®

S P X ®

S E R I E S
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S E A  R A Y
S P X ®  1 9 0  O B
FEATURES

>> Shown with STD Viper Swam & Flint Upholstery

>> Mercury FourStroke outboard offers reliability and fuel 
efficiency

>> Deep Strorage below sunpad

>> Shown with Captains Package 

FONCTIONNALITÉS

>> Présenté avec la sellerie de série swan

>> Fiabilité et consommation réduite avec le moteur  
hors-bord Mercury 4 temps

>> Rangement profond sous le bain de soleil

>> Présenté avec le Pack Capitaine 

CARACTERÍSTICAS

>> Se muestra con tapicería estándar Viper en color blanco 
cisne y gris piedra

>> El motor fueraborda de cuatro tiempos Mercury ofrece 
fiabilidad y eficiencia de combustible

>> Gran espacio de estiba debajo del solárium

>> Se muestra con paquete Capitán 

EIGENSCHAFTEN

>> Abgebildet mit STD „Viper“ Swam & Flint-Polster

>> Mercury Viertakt-Außenbordmotor bietet 
Zuverlässigkeit und Kraftstoffeffizienz

>> Viel Stauraum unter der Sonnenliege

>> Abgebildet in Captains-Ausführung
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S E A  R A Y
S P X ®  1 9 0  O B

113 L

8P / 910 KG

1,131 KG

5,94 M | 2,54 M

FEATURES

>> Shown with optional select package“Bella Grana” 
Off White & Praline Upholstery

>> Deep bow seating features ample storage below

FONCTIONNALITÉS

>> Présenté avec la sellerie « Bella Grana » blanc cassé et 
praline du kit Sélection en option

>> Cockpit convertible

CARACTERÍSTICAS

>> Se muestra con la tapicería “Bella Grana” de color blanco 
roto y marrón praliné del paquete Selecto opcional

>> Bañera de diseño versátil 

EIGENSCHAFTEN

>> Abgebildet in der optionalen Ausstattung Select „Bella 
Grana“ Polster Off White & Praline

>> Umbaubares Cockpit
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FEATURES

>> Shown with STD “Viper” Swan & Flint Upholstery

>> Wide bow design

>> Standard elegant dash

>> Full beam platform close to waterline 

CARACTÉRISTIQUES

>> Présenté avec la sellerie de série « Viper » swan

>> Étrave large

>> Tableau de bord élégant de série

>> Grande plate-forme proche de la ligne de flottaison 

CARACTERÍSTICAS

>> Se muestra con tapicería estándar “Viper” en color 
blanco cisne y gris piedra

>> Diseño amplio de proa

>> Elegante salpicadero estándar

>> Plataforma cerca del agua todo a lo ancho de la manga 

EIGENSCHAFTEN

>> Abgebildet mit STD “Viper” Swan & Flint-Polster

>> Großzügig angelegter Bug

>> Serienmäßig elegantes Armaturenbrett

>> Badeplattform über die gesamte Breite, nahe am 
Wasserspiegel

S E A  R A Y
S P X ®  1 9 0

2 0
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S E A  R A Y
S P X ®  1 9 0

113 L

8 P / 1350 KG

1.350 KG

5,94 M | 2,54 M

FEATURES

>> Convertible port-side seating with fill-in cushions

>> Deep bow seating with integrated storage below

>> Three all-inclusive optional packages: 
Captain’s, Select and Elevation 

CARACTÉRISTIQUES

>> Sièges bâbord convertibles avec coussins 
supplémentaires

>> Sièges de proue profonds avec rangement intégré en 
dessous

>> Trois kits optionnels tout compris: 
Capitaine, Sélection et Élévation 

CARACTERÍSTICAS

>> Asiento a babor convertible con colchonetas 

>> Asientos de proa profundos con espacio de estiba 
integrado debajo

>> Tres paquetes opcionales todo incluido:  
Capitán, Selecto y Elevación 

EIGENSCHAFTEN

>> Umklappbare Sitze Backbord mit optionalem Polster

>> Tiefer Bug-Sitzplatz mit Stauraum darunter

>> Mit drei kompletten Ausführungsvarianten: 
Captain’s, Select und Elevation
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FEATURES

>> Shown with optional select package“Bella Grana” 
Off White & Praline Upholstery

>> Convertible bench seat with forward cushion and aft 
bolster

>> Full beam round seating with cooler 

CARACTÉRISTIQUES

>> Présenté avec la sellerie « Bella Grana » blanc cassé  
et praline du kit Sélection en option

>> Banquette convertible avec coussin avant  
et coussinet amovible

>> Grand siège en demi-cercle avec glacièreer 

CARACTERÍSTICAS

>> Se muestra con la tapicería “Bella Grana” de color  
blanco roto y marrón praliné del paquete Selecto 
opcional

>> Asiento de popa convertible con cojín frontal  
y apoyo de popa

>> Banco redondo en toda la manga con refrigerador 

EIGENSCHAFTEN

>> Abgebildet in der optionalen Ausstattung Select  
„Bella Grana“ Polster Off White & Praline

>> Verstellbare Bank mit nach vorne und nach hinten 
gerichtetem Polster

>> Über die gesamte Breite rund angeordnete Sitze mit 
Kühlbox

S E A  R A Y
S P X ®  2 1 0



2 72 6

S
P

X
 S

E
R

IE
S

 | S
E

A
 R

A
Y

 S
P

X
 2

10

S E A  R A Y
S P X ®  2 1 0

151 L

10 P / 818 KG

1.542 KG

6,55 M | 2,54 M

FEATURES

>> Shown with Elevation Package

>> Shown with Sea deck Mocha

>> FM stereo with waterproof speakers 

CARACTÉRISTIQUES

>> Présenté avec Kit Elévation

>> Présenté avec pont moka

>> Radio FM avec haut-parleurs résistants  
aux intempéries 

CARACTERÍSTICAS

>> Se muestra con Paquete de Elévation

>> Se muestra con cubierta color mocca

>> Equipo estéreo con altavoces étanche 

EIGENSCHAFTEN

>> Abgebildet mit Elevation-Ausführung

>> Abgebildet mit Seadek auf der Badeplattform  
in Mocca

>> FM Stereo mit wasserdichten Lautsprechern 



2 92 8

S
P

X
 S

E
R

IE
S

 |  S
E

A
 R

A
Y

 S
P

X
 2

3
0

FEATURES

>> Shown with cockpit upholstery, Viper Swan & Flint

>> Head compartment with lockable door and storage

>> Shown with captain’s package, with bow filler and 
forward backrest cushions 

CARACTÉRISTIQUES

>> Présenté avec la sellerie, Viper swan

>> Compartiment toilettes

>> Présenté avec  KIT DU CAPITAINE Bain de soleil avant 
avec dossier avant

CARACTERÍSTICAS

>> Se muestra con la tapicería, Viper blanco cisne y gris

>> Cuarto de baño

>> Se muestra con PAQUETE CAPITÁN  Colchoneta de proa 
con respaldo Parte central 

EIGENSCHAFTEN

>> Abgebildet in der Polster Viper Swan & Flint

>> Geschlossene Nasszelle

>> Abgebildet mit Bugfüllpolster

S E A  R A Y
S P X ®  2 3 0

2 8
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S E A  R A Y
S P X ®  2 3 0

189 L

13 P / 1038

2.008 KG

7.15 M | 2,54 M

FEATURES

>> Shown with dual bucketseat with swivel, slider and 
flip-up bolster

>> Full beam sunpad with walk thru cusion

>> Shown with submersable swimplatform 

CARACTÉRISTIQUES

>> 2 sièges baquets avec coussinets relevables

>> Bain de soleil avec ouverture centrale bâbord intégrée

>> Plateforme de bain submersible manuellement 

CARACTERÍSTICAS

>> Asientos giratorios (2), con apoyo abatible para elevar 
las piernas

>> Solárium con paso de acceso a espejo de popa

>> Plataforma de Baño Sumergible, Manual 

EIGENSCHAFTEN

>> Schalensitze (2) mit hochklappbaren Schenkelpolstern

>> Sonnenliege mit integriertem Heck-Durchgang

>> Manuelle Unterwasserplattform
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SERIES
SLX

®

For the discerning professional in search of a premium watercraft 
that looks and sounds as good as it performs, the SLX provides 

performance with passion, because only the SLX delivers high-end 
styling, superior fit and finish and exceptional performance in  

a bowrider.

Destiné aux passionnés amateurs de sensations fortes qui 
recherchent un bateau de qualité aussi élégant que performant, 
le SLX fait rimer performances et passion grâce à son élégance, 

à ses finitions de qualité supérieure et à ses performances 
exceptionnelles.

Para los profesionales exigentes que buscan una embarcación 
óptima con un aspecto y sonido igual de óptimo que su 

rendimiento, la serie SLX aúna prestaciones y pasión, al ser la 
única serie que ofrece un estilismo de primera categoría, una 

calidad y acabados excelentes y un rendimiento excepcional en 
una embarcación de proa abierta.

Für den anspruchsvollen Profi auf der Suche nach einem 
Premium-Boot, das so gut aussieht und klingt wie es auch 

tatsächlich ist, ist die SLX-Serie genau das Richtige. Sie verbindet 
Leistung mit Leidenschaft. Sie zeichnet sich durch ein High-End-

Design, einen anspruchsvollen Bau, hochwertige Verarbeitung und 
eine außergewöhnliche Leistung in einem Bowrider aus.

3 3

S L X ®

S E R I E S
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S E A  R A Y
S L X ®  2 5 0

FEATURES

>> Convertible bench seat with forward cushion  
and aft bolster

>> Full beam round seating 

>> FM stereo with Wireless Bluetooth™  

FONCTIONNALITÉS

>> Banquette convertible avec coussin avant  
et coussinet amovible

>> Grande banquette en demi-cercle

>> Radio avec Bluetooth™ intégré 

CARACTERÍSTICAS

>> Asiento de popa convertible con cojín frontal y  
apoyo de popa

>> Banco redondo en toda la manga

>> Equipo estéreo FM con Bluetooth™ inalámbrico 

EIGENSCHAFTEN

>> Verstellbare Sitzbank mit Kissen vorne und Polster 
achtern

>> Runde Sitzbank über die gesamte Breite

>> FM Stereo mit Wireless Bluetooth™
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283 L

12 P / 968 KG

2.631 KG

7,9 M | 2,59 M

FEATURES

>> Shown with Elevation Package

>> Optional built-in cockpit refrigerator 

>> Available with multiple gel coat hull color choices 

FONCTIONNALITÉS

>> Présenté avec Kit Elévation

>> Réfrigérateur de cockpit intégré en option

>> Multiple choix de couleurs de gelcoat pour la coque 

CARACTERÍSTICAS

>> Se muestra con Paquete de Elévation

>> Nevera integrada opcional en la bañera

>> Disponible en varios colores del revestimiento  
de gel del casco 

EIGENSCHAFTEN

>> Abgebildet mit Elevation-Ausführung

>> Optional mit Einbaukühlschrank im Cockpit

>> Erhältlich mit Gelbeschichtung für den Rumpf in 
verschiedenen Farben
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SERIES
SDX

®

For the active family seeking a crowd-pleasing, premium 
watercraft, the SDX epitomizes fun and socializing capabilities, 

because only the SDX delivers a spacious, durable runabout that’s 
easy to use with bow and stern access for the entire family.

Destiné aux familles actives qui recherchent un bateau de grande 
classe apprécié de tous, le SDX est synonyme de convivialité grâce 

à son aménagement spacieux et ergonomique,  
la famille et les amis se sentent très à l’aise et circulent 

facilement dans le bateau.

Para las familias activas que buscan una embarcación óptima y 
que agrade a todos, el SDX es sinónimo de diversión y de tiempo 

juntos, ya que solo el SDX ofrece una embarcación espaciosa, 
duradera e idónea para toda la familia, gracias a su cómodo acceso 

a la popa y la proa.

Für die aktive Familie, die ein ansprechendes Premium-
Boot sucht, verkörpert die SDX-Serie Spaß und Geselligkeit. 

Diese geräumigen und gleichzeitig robusten Sportboote 
sind unkompliziert in der Handhabung und bieten Bug-und 

Heckzugang für die ganze Familie.

3 9

S D X ®

S E R I E S
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FEATURES

>> Spacious full-beam cockpit floorplan 

>> Convertible seating, including sunpad/aft-facing 
transom lounger 

>> �Stereo with wireless Bluetooth™ for easy control  
of audio devices onboard 

>> �Enclosed head compartment with toilet,  
vanity and sink 

FONCTIONNALITÉS

>> Cockpit spacieux et luxueux

>> Sièges convertibles, dont un avec bain de soleil/ 
transat arrière (orienté plate-forme)

>> Chaîne stéréo avec Bluetooth™ pour faciliter  
la gestion des appareils audio à bord

>> Compartiment toilettes fermé avec WC portable,  
lavabo et meuble sous vasque 

CARACTERÍSTICAS

>> Gran bañera que ocupa todo el ancho

>> Asientos convertibles, incluyendo tumbona solárium  
en el espejo y cara a popa.

>> Equipo estéreo con Bluetooth™ inalámbrico que facilita 
el control de los dispositivos de audio a bordo

>> Cuarto de baño con inodoro portátil, tocador y lavabo 

EIGENSCHAFTEN

>> Geräumiges Cockpit über die volle Breite

>> Umklappbare Sitze, einschließlich Sonnenliege/nach 
achtern gerichtete Heckliege

>> Stereo mit Wireless Bluetooth™ für die einfache 
Steuerung von Audiogeräten an Bord

>> Geschlossene Nasszelle mit elektrischer Toilette,  
Waschtisch und -becken

4 0
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246 L

12P / 950 KG

2.567 KG

8,30 M | 2,59 M

features & standard equipment

Mercruiser® 6.2L MPI Bravo® III w/DTS Sterndrive  
(300 hp - 224 kW)

CE Option Group
Smartcraft® diagnostics w/ Depth Finder
Bimini Top w/boot
Canvas Cockpit Cover w/Tonneau Cover
Integrated swim platform w/recessed stainless-steel 

four step swim ladder
Windshield Wiper - Starboard
Ski tow eye-transom - flush mount
Color Coordinated Vinyls w/Diamond Pattern and 

Accent Vinyls: Sand (Pearl) with Sterling snap-in 
carpet liner

Cockpit table, fiberglass
Bow lounger seats w/hinged cushions & flip-down 

armrests
Helm bench seat w/convertible backrest & sliding base
Aft facing transom lounger
Walk thru windshield
76 litre capacity pressure water system
Enclosed head compartment with portable toilet
Beverage holders, stainless steel
Stereo, 12V AM/FM, Wireless Bluetooth™, 

weatherproof speakers (4) & digital cockpit remote 
control

Storage, Side Panel - upper & lower
CE Fire Suppression System - automatic w/manual 

pull

options & accessories
Mercruiser 6.2L MPI Bravo III w/DTS Sterndrive  

(350 php - 261 kW)
Mercruiser 8.2 MAG Bravo III w/DTS Sterndrive  

(380 php - 261 kW)
ECT Engines Available

canvas package (for standard bimini top or 
optional watersports tower):

Aft Curtain
Front Curtains
Side Curtains
Canvas Storage Bag

individual options:
Air Compressor for Water Toys
Battery Charger (220/50 - 12 volt)
Bottom Paint
Canvas Mooring Cover (Black Only)
Chartplotter, Raymarine® 
Cockpit Color Option: Espresso (Beige) w/Country 

Beige Carpet
Cockpit Heating (From Engine)
Digital Dash: Includes Raymarine® Chartplotter & 

Audio Control via Upgraded Fusion 750 Series Stereo 
Head Unit

Docking Lights
Filler Cushions - Bow

Gel Coat, Full Color Hull (Arctic White, Black, Sea Ray 
Blue, Ocean Blue, Gray, Rally Red or Mojave Tan)

Gel Coat, Two-Tone (Arctic White, Black, Sea Ray Blue, 
Ocean Blue, Gray, Rally Red or Mojave Tan)

Gel Coat, Three-Tone (Arctic White, Black, Sea Ray 
Blue, Ocean Blue, Gray, Rally Red or Mojave Tan)

Graphics, Optional; Saphire Blue or Brushed Chrome 
- Taped

Head, Pump-Out
Head System, VacuFlush w/37 Litre Holding Tank
Hot Water System Upgrade
Lighting, Indirect Blue or White LED - Bow & Cockpit
Lighting, Thru Hull Underwater, LED
Premium Ski Mirror
Real Teak Upgrade to Cockpit (Replaces Carpet)
Real Teak on Swim Platform
Refrigerator in Cockpit
SeaDek® Swim Platform Matting - Faux Teak
Swim Platform, Submersible, Manual
Swiss Specs - Oil Drip Pan Under Engine
Table, Bow w/Designated Storage
Tower, Watersports, White Aluminum w/Tilting 

Bimini Storage System
Trim Tabs, Hydraulic
Wakeboard Racks, Swivel
Wet Bar w/Integral Sink & Faucet
Windlass - Electric w/ Galvanized Anchor & Chain
Windlass - Electric w/Chain & Stainless Steel Anchor

SDX® 270

Standard Seating Plan

For information +31 20 511 00 11. Internet address: http://www.searay.com  
Note: Not all accessories shown in pictures or described herein are standard equipment or even available as options. Options and features are subject to change without notice. 

Not all model year boats may contain all the features or meet the specifications described herein. Confirm availability of all accessories and equipment with an authorized Sea Ray dealer prior to purchase.

06222016Sponsor of ABYC Marine  
Certification School

FEATURES

>> Abundance of available shade, via the standard bimini 
top or an optional watersports tower 

>> Shown with submersible swim platform option 

>> Best-in-Class comfortably seats 12 people while 
underway (yacht certified)  

FONCTIONNALITÉS

>> Ombre en abondance grâce à la bâche Bimini de série  
ou tour de sports nautiques en option

>> Présenté avec plate-forme de bain submersible  
en option 

CARACTERÍSTICAS

>> Gran cantidad de sombra, gracias al toldo Bimini  
de serie o la torre para deportes acuáticos opcional

>> Se muestra con plataforma de baño sumergible  
opcional 

EIGENSCHAFTEN

>> Reichlicher Sonnenschutz dank serienmäßigem  
Bimini-Verdeck oder einem optionalen  
Wakeboardtower

>> Abgebildet mit optionaler absenkbarer Badeplattform



4 4 4 5

SERIES
SUN SPORT

®

Tailored to the European and International markets, the Sea Ray 
Sun Sport is the boat of choice, because only Sea Ray delivers  
a runabout with superior craftsmanship and a well-appointed 

cabin designed to duck out of surf and sun or escape for an 
overnight getaway.

Spécialement conçue pour les marchés européens et 
internationaux, la série Sun Sport illustre le savoir-faire de  

Sea Ray avec sa cabine entièrement aménagée qui permet de  
se reposer du soleil et des vagues ou de de dormir à bord  

le temps d’un week-end.

El Sun Sport, concebido para los mercados europeo y extranjero, 
es la opción ideal, ya que solo Sea Ray ofrece una embarcación con 
una construcción suprema y una cabina bien equipada, diseñada 
para escapar del sol y las olas o realizar una escapada nocturna.

Abgestimmt auf die europäischen und internationalen Märkte ist 
das Sea Ray Sun Sport das Boot der Wahl, denn nur Sea Ray bietet 

ein Sportboot mit überlegener handwerklicher Verarbeitung und 
einer gut ausgestatteten Kabine, um sich von Surfen und Sonne 

zurückzuziehen oder auch einmal eine Auszeit zu nehmen und an 
Bord zu übernachten.

4 5

S U N  S P O R T ®

S E R I E S
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FEATURES

>> Recessed sunpad in bow

>> Cuddy cabin that accomadates two people

>> Shown with cockpit upholstery Bella Grana praline and  
off-white 

CARACTÉRISTIQUES

>> Bain de soleil avant

>> Cabine confortable avec grande couchette et WC

>> Présenté avec le kit Capitaine 

CARACTERÍSTICAS

>> Colchoneta de proa

>> Elegante cabina con litera grande e inodoro

>> Se muestra con paquete Capitán 

EIGENSCHAFTEN

>> Sonnenliege auf dem Vorderdeck

>> Gut ausgestattet Kabine mit großer Koje und WC

>> Abgebildet in Captains-Ausführung

S E A  R A Y
S U N  S P O R T ®  2 3 0

4 6
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189 L

8 P / 870 KG

2.218 KG

7,15 M | 2,54 M

FEATURES

>> Electric windlass and stainless steel anchor

>> Full beam round seating

>> Submersible Swimplatform, Manual Operated 

CARACTÉRISTIQUES

>> Guindeau éléctrique avec chaîne et ancre inox

>> Assise passager babord reversible

>> Plateforme de bain submersible manuellement 

CARACTERÍSTICAS

>> Molinete con ancla en acero inox

>> Asiento babor reversible

>> Plataforma de Baño Sumergible, Manual 

EIGENSCHAFTEN

>> Elektrische Ankerwinde mit Kette und Edelstahlanker

>> Umklappbarer Beifahrersitz /Sitzbank

>> Manuelle Unterwasserplattform
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FEATURES

>> Shown with cockpit upholstery, espresso beige

>> Transom sun pad 

>> FM stereo with Wireless Bluetooth™ 

>> Cuddy Cabin with Large berth and toilet 

FONCTIONNALITÉS

>> Présenté avec la sellerie, expresso beige

>> Bain de soleil arrière avec extension coulissante

>> Radio avec Bluetooth™ intégré

>> Cabine confortable avec grande couchette et WC 

CARACTERÍSTICAS

>> Se muestra con la tapicería, espresso beige

>> Solárium de popa con extensión deslizante

>> Equipo estéreo FM con Bluetooth™ inalámbrico

>> Elegante cabina con litera grande e inodoro 

EIGENSCHAFTEN

>> Abgebildet in der Polster, espresso beige

>> Heck-Sonnenliege mit herausziehbarer Verlängerung

>> FM Stereo mit Wireless Bluetooth™

>> Gut ausgestattet Kabine mit großer Koje und WC
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283 L

8 P / 645 KG

2.631 KG

7,9 M | 2,59 M

FEATURES

>> Standard extended swim platform 

>> Optional built-in cockpit refrigerator 

>> Shown with Captains package

>> Available with multiple gel coat hull color choices 

FONCTIONNALITÉS

>> Plateforme de bain XXL de série

>> Réfrigérateur de cockpit intégré en option

>> Présenté avec le kit Capitaine

>> Multiple choix de couleurs de  
gelcoat pour la coque 

CARACTERÍSTICAS

>> Plataforma de baño extendida de serie

>> Nevera integrada opcional en la bañera

>> Se muestra con paquete Capitán

>> Disponible en varios colores del revestimiento  
de gel del casco 

EIGENSCHAFTEN

>> Serienmäßig mit verlängerter Badeplattform

>> Optional mit Einbaukühlschrank im Cockpit

>> Abgebildet in Captains-Ausführung

>> Erhältlich mit Gelbeschichtung für den Rumpf in 
verschiedenen Farben
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For the accomplished boating enthusiast who never stops aspiring,
the Sundancer is the ultimate trophy, because only the Sundancer 
offers elegant styling and performance in a long-range watercraft 

designed for socializing, a brand recognized the world over as
a hallmark of achievement and a range of products they can trade 

into along their own upward life journey.

Pour tous ceux qui recherchent l’excellence, la gamme Sundancer 
est l’ultime récompense. Avec un style et des performances 

remarquables, la série Sundancer est mondialement reconnue et 
vous permettra de vivre des moments exceptionnels sur l’eau.

Para el navegante consumado que nunca deja de aspirar a más, 
el Sundancer es el trofeo definitivo, porque es el único que ofrece 
embarcaciones de largo alcance con un diseño elegante y un gran 

rendimiento diseñadas para sociabilizar; una marca reconocida 
en todo el mundo como un ejemplo de éxito y poseedora de una 

gama de productos entre los que puede ir cambiando para ir 
mejorando a lo largo de su vida.

Für den versierten Bootsliebhaber, der nie aufhört nach Höherem 
zu streben, ist eine Sundancer die ultimative Trophäe. Denn 
nur die Sundancer Modelle bieten ein Mehr an Eleganz, Stil 
und Leistung, übertreffen damit die Anforderungen an ein 

Cruisermodell für geselliges Beisammensein. Die Sundancer 
Modelle sind weltweit bekannt und beliebt und gelten als das 

Markenzeichen der Sea Ray Familie.

S U N D A N C E R ®

S E R I E S

SUNDANCER
®

SERIES

5 5
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FEATURES

>> Stereo, MP3 / USB Port, 4 Weatherproof Speakers

>> Starboard windshield wiper

>> Windlass - Electric with Chain & SST Anchor 

CARACTÉRISTIQUES

>> Lecteur de stéréo avec port MP3/USB, 4 haut-parleurs 
étanches

>> Essuie-glace tribord

>> Guindeau éléctrique avec chaîne et inox 

CARACTERÍSTICAS

>> Equipo estereofónico con puerto MP3/USB 4 altavoces 
a prueba de intemperie

>> Limpiaparabrisas a estribor

>> Molinete electrico con ancla de Acero 

EIGENSCHAFTEN

>> Stereoanlage mit MP3-/USB-Anschluss und 4 
wasserdichten Lautsprechern

>> Scheibenwischer steuerbord

>> Elektrische Ankerwinde mit Kette und edelstahlanler

S E A  R A Y
S U N D A N C E R ®  2 6 5

5 6
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FEATURES

>> Shown with standard Walnut interior

>> Sleeps up to four people

>> Enclosed Toilet with shower 

CARACTÉRISTIQUES

>> Présenté avec intérieur noyer de série

>> Couchage pour quatre personnes maximum

>> WC fermés avec douche 

CARACTERÍSTICAS

>> Se muestra con interior estándar en color nogal

>> Capacidad de pernocta para hasta cuatro personas

>> Baño independiente con ducha 

EIGENSCHAFTEN

>> Abgebildet mit serienmäßiger Innenausstattung 
Nussbaum

>> Bietet bis zu vier Schlafplätze

>> Geschlossener WC-Raum mit Dusche

S E A  R A Y
S U N D A N C E R ®  2 6 5
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FEATURES

>> Swim Platform with Swim Ladder

>> Teak Cockpit Table

>> Fold-down transom seat that converts to sun pad 

CARACTÉRISTIQUES

>> Plate-forme de bain avec échelle de bain

>> Table de cockpit en teck

>> Banquette arrière convertible en bain de soleil 

CARACTERÍSTICAS

>> Plataforma de baño con escalera

>> Mesa de bañera de teca

>> El asiento plegable de popa se convierte en solárium 

EIGENSCHAFTEN

>> Badeplattform mit Badeleiter 

>> Cockpit-Tisch, Teakholz

>> Herunterklappbarer Hecksitzplatz, der in eine 
Sonnenliege umgewandelt werden kann

S E A  R A Y
S U N D A N C E R ®  2 6 5

261 L

8 P / 820 KG

4 P

2.875 KG

8,07 M | 2,59 M
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FEATURES

>> Robust bow lounging and seating

>> Optional transom sungate

>> Teak cockpit table converting to sunpad

>> Cockpit galley with sink and refrigerator 

CARACTÉRISTIQUES

>> Tableau arrière convertible en bain de soleil

>> Table de cockpit teck convertible bain de soleil

>> Cuisine dans le cockpit avec réfrigérateur 

CARACTERÍSTICAS

>> Asientos en colchoneta de Popa

>> Mesa en bañera en teka - convertible a solarium

>> Cocina en la bañera con frigorífico y fogón

EIGENSCHAFTEN

>> Transom Sonnenliege

>> Sitzgruppe achtern mit Cockpittisch / Sonnenliege

>> Kombüse im Cockpit mit Spüle

S E A  R A Y
S U N D A N C E R ®  3 2 0

6 2
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FEATURES

>> Shown with standard optional driftwood interior

>> Sleeps up to four people

>> Enclosed Toilet with shower 

CARACTÉRISTIQUES

>> Présenté avec intérieur noyer de série

>> Couchage pour quatre personnes maximum

>> WC fermés avec douche 

CARACTERÍSTICAS

>> Se muestra con interior estándar en color nogal

>> Capacidad de pernocta para hasta cuatro personas

>> Baño independiente con ducha 

EIGENSCHAFTEN

>> Abgebildet mit serienmäßiger Innenausstattung 
Nussbaum

>> Bietet bis zu vier Schlafplätze

>> Geschlossener WC-Raum mit Dusche

S E A  R A Y
S U N D A N C E R ®  3 2 0
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FEATURES

>> Shown with optional hardtop and opening canvas 
section

>> With the teak flooring upgrade

>> Cockpit upholstery sand 

CARACTÉRISTIQUES

>> Hardtop polyester  Taud de fermeture arrière pour

>> Plancher entier en teck. Avant, cockpit, et plateforme de 
bain

>> Guindeau éléctrique avec chaîne et ancre inox 

CARACTERÍSTICAS

>> Hard top de fibra Techo Rígido con

>> Suelo de Teca - Bañera y & Plataforma de Baño

>> Molinete con Cadena y con ancla acero inox 

EIGENSCHAFTEN

>> Hardtop aus GfK  Lukenausschnitt (Verdeckeinlass)

>> Teakboden im Cockpit und auf der Badeplattform

>> Elektrische Ankerwinde mit Kette und Edelstahlanker

S E A  R A Y
S U N D A N C E R ®  3 2 0

643 L

10 P / 1217 KG

4 P

6.500 KG

9.85 M | 3.25 M
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FEATURES

>> Optional anchor windlass

>> Standard fiberglass sport spoiler

>> Teak Table with Sun Pad Filler Cushions 

CARACTÉRISTIQUES

>> Guindeau d’ancre en option

>> Spoiler en fibre de verre de série

>> Table en teck et coussins amovibles pour bain de soleil 

CARACTERÍSTICAS

>> Molinete opcional

>> Alerón deportivo de fibra de vidrio estándar

>> Mesa de teca con colchonetas para el solárium 

EIGENSCHAFTEN

>> Ankerwinde (Option)

>> Serienmäßig mit Sportspoiler aus Fiberglas

>> Tisch im Cockpit aus massivem Teakholz und Füllkissen 
für die Sonnenliege

S E A  R A Y
S U N D A N C E R ®  3 5 5
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FEATURES

>> Shown with standard Walnut interior, Shoji doors and 
wooden flooring

>> Forward cabin with privacy door

>> Mid-cabin with privacy door

>> Enclosed Shower with Door 

CARACTÉRISTIQUES

>> Présenté avec intérieur noyer, portes Shoji et plancher 
en bois de série

>> Cabine avant avec porte

>> Cabine centrale avec porte

>> Douche fermée avec porte 

CARACTERÍSTICAS

>> Se muestra con el interior de nogal estándar,  
puertas shoji y suelo de madera

>> Cabina delantera con puerta para preservar la intimidad

>> Cabina central con puerta para preservar la intimidad

>> Cabina de ducha con puerta 

EIGENSCHAFTEN

>> Abgebildet mit serienmäßiger Innenausstattung  
in Nussbaum, Shoji-Türen und Holzfußboden

>> Vorderkabine mit Tür

>> Mittelkabine mit Tür

>> Geschlossene Dusche mit Tür

S E A  R A Y
S U N D A N C E R ®  3 5 5
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FEATURES

>> Optional hardtop

>> Extended swim platform

>> Optional sunpad forward deck 

CARACTÉRISTIQUES

>> Toit rigide en option

>> Plate-forme de bain extérieure

>> Coussins de bain de soleil avant optionnels 

CARACTERÍSTICAS

>> Techo duro opcional

>> Plataforma de baño extendida

>> Solárium opcional en la cubierta de proa 

EIGENSCHAFTEN

>> Optional mit festem Verdeck

>> Verlängerte Badeplattform

>> Sonnenliege auf dem Vorderdeck (Option)

S E A  R A Y
S U N D A N C E R ®  3 5 5

760 L

12 P / 1360 KG

6 P

6.900 KG

11.2 M / 3,48M
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UPHOLSTERY FABRICS & FINISHES
FLOORING  |  SOL  |  SUELOS  |  FUSSBODEN

snap-in carpet  infinity flooring teak cockpit teak swim platform

sport opt opt - -

spx / sun sport 230 opt opt - -

slx / sun sport 250 std opt opt opt

sdx std opt opt opt

sundancer std opt opt opt

UPHOLSTERY  |  SELLERIE  |  TAPICERÍA  |  POLSTER

Viper 
Swan & Flint 

bella grana 
praline & off white

sport std opt

spx / sun sport 230 std opt

sundancer - opt

UPHOLSTERY  |  SELLERIE  |  TAPICERÍA  |  POLSTER

sand (pearl) with 
sterling snap-in carpet liner 

espresso (beige) 
w/country  beige carpet 

slx / sun sp0rt 250 std opt

sdx std opt

sundancer std opt

1

3

5
5

6
6

2

INTERIOR  |  INTÉRIEUR  |  INTERIOR | INNENRAUM

walnut wood interiot
with luxury shoji doors 

Drift wood
with luxury shoji doors

sundancer std opt 320 only

2

3 2

3 4

4

1

4

3

3

21

1

5 6

2 3 4
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FEATURES & OPTIONS
SPORT BOATS

1

3

2 74 8
5

9

1 0

6

	 1. 	 SeaDek covering on Swim Platform 

	2. 	 Built in refrigerator
	3. 	 Fresh water system
	4. 	 Submersible swim platform 
 

	 1. 	 Sea deck sur plateforme de bain
	2. 	 Réfrigérateur intégré
	3. 	 Distributeur d’eau douce
	4. 	 Plate-forme de bain submersible 
 

	 1. 	 SeaDek- Plataforma de Baño 
	2. 	 Nevera integrada
	3. 	 Sistema de agua fresca
	4. 	 Plataforma de baño sumergible 
 

	 1. 	 Seadek Belag auf der Badeplattform
	2. 	 Einbaukühlschrank
	3. 	 Frischwassersystem
	4. 	 Absenkbare Badeplattform

	5. 	 Windlass - Electric with Chain & SST Anchor
	6. 	 Sunpad walk thru
 7. 		 Bow door wind stopper
	8. 	 Head with electrical toilet
	9. 	 Teak table upgrade 
10.	  Water Sports Tower w/ Bimini Top

	5. 	 Guindeau éléctrique avec chaîne et inox
	6. 	 Coussin bain de soleil arrière
 7. 		 Porte avant pour protéger du vent
	8. 	 Compartiment toilettes avec WC électrique
	9. 	 Table en teck
10.	 Tour de wake-board avec bimini inox 
 

	5. 	 Molinete electrico con ancla de Acero
	6. 	 Colchoneta paso solarium
	 7. 	 Solárium
	8. 	 Cuarto de baño con inodoro eléctrico
	9. 	 Mejora a mesa de teca
10.	 Fundas para Bañera y Proa 

	5. 	 Elektrische Ankerwinde mit Kette und 
edelstahlanler
	6. 	 Füllpolster für die Sonnenliege	
 7. 		 Sundeck
	8. 	 Nasszelle mit elektrischer Toilette
	9. 	 Teaktisch-Upgrade
10.	 Sportpersenning und Bugabdeckung
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FEATURES & OPTIONS
SPORT CRUISERS

1

3

2

4

5

1. 	 LED Package in Cockpit - Blue or White
2. 	�Hardtop with opening Canvas Section
3. 	� Cockpit Table with Teak - converting to Sunpad
4. 	Optional sunpad forward deck
5. 	�Cockpit Galley 

1. 	 Package LED dans le Cockpit- bleu ou blanc
2. 	�Hardtop avec taud de fermeture arrière pour 
3. 	� Table de cockpit teck convertible bain de soleil
4. 	Coussins de bain de soleil avant optionnels
5. 	�Cuisine dans le cockpit

1. 	 Conjunto Luces LED en Bañera: Azul o blanca
2. 	Hard top de fibra 
3. 	Mesa en bañera en teka - convertible a solarium
4. 	Solárium opcional en la cubierta de proa
5. 	�Cocina en la bañera

1. 	 Blaues oder weißes LED-Lichtpaket
2. 	�Lukenausschnitt (Verdeckeinlass) für Hardtop
3. 	� Sitzgruppe achtern mit Cockpittisch / Sonnenliege
4. 	Sonnenliege auf dem Vorderdeck (Option)
5. 	�Kombüse im Cockpit

OPTIONS & SPECS
No two journeys are alike. Choose the propulsion options, creature 

comforts and finishes packages that best reflect your personal style. 

Technical accessories and life’s necessities help maximize the poten-

tial of your voyage. Command the waters.

OPTIONS ET SPÉCIFICATIONS
À chacun son tempérament. Choisissez les options de propulsion,  

de confort et de finition qui correspondent le mieux à votre style 

personnel. Les accessoires techniques et les produits de première 

nécessité optimisent le potentiel de votre voyage. Maîtrisez les eaux.

OPCIONES Y CARACTERÍSTICAS
No hay dos viajes iguales. Elija las opciones de propulsión, las como- 

didades y paquetes de acabados que mejor reflejen su estilo personal.  

Los accesorios técnicos y todo lo que necesita a bordo le ayudan  

a disfrutar al máximo de su viaje. Sea amo y señor de las aguas.

OPTIONEN UND  
TECHNISCHE ANGABEN

Keine Reise gleicht der anderen. Wählen Sie Ihren Antrieb,  

die Ausstattung und das Design, die am besten zu Ihrem 

persönlichen Stil passen. Mit dem technischen Zubehör und  

den praktischen Lösungen holen Sie alles aus Ihrer Reise heraus.  

Das Wasser gehört Ihnen.

bimini top cockpit cover
taud bimini taud de cockpit

toldo bimini cubierta de la bañera
bimini-verdeck cockpit-verdeck

spx / sun sport 230 opt opt

slx / sun sport 250 std opt

sdx std std

sundancer std opt

canvas package for bimini top camper canvas package
kit taud pour bimini kit taud camper

paquete de lonas para el toldo bimini paquete de lonas camper
segeltuchpaket für bimini-verdeck camper-verdeck

spx / sun sport 230 opt -

slx / sun sport 250 opt -

sdx opt -
sundancer std opt

COLOR CANVAS  |  TAUD DE COULEUR  |  COLOR DE LA LONA  |  SEGELTUCHFARBE
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FEATURES & STANDARD EQUIPMENT
>	�MerCruiser® 4.5 MPI Alpha I (200HP - 149 KW)
>	�Stainless Steel Sea Ray Custom Cleat
>	�Gel Coat, Arctic White
>	�Lights, Navigation - Stainless Steel
>	�Ski Tow Eye, Stainless Steel
>	�Swim Platform, Additional Extended w/Stainless-Steel, Three-Step 

Swim Ladder & Grab Handle
>	�Beverage Holders, Stainless Steel 
>	�Grab Handles, Stainless Steel
>	�Outlet, 12V Accessory
>	�Stereo, 12V FM Single CD & MP3 Port w/Weatherproof Speakers (4)
>	�Bucket Seats (2), w/Flip-Up Thigh Rise, Swivel & Slider Functions & 

Sport Logos
>	�Sun Pad w/Integrated Transom Walk-Thru
>	�CE Fire Suppression System - automatic w/manual pull
>	�CE Certification “C”

OPTIONS & ACCESSORIES

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	��Moteur mixte MerCruiser® ECT 4.5 Alpha® I (200 ch – 149kW)
>	� Taquets exclusifs Sea Ray en acier inoxydable
>	� Couleur Gelcoat blanc arctique
>	� Feux de navigation en acier inoxydable
>	� Œillet de ski nautique en acier inoxydable
>	�� Plate-forme de bain XXL grandes dimensions avec échelle de bain à trois 

marches en acier inoxydable et poignée intégrée
>	� Porte-verres en acier inoxydable
>	� Poignées en acier inoxydable
>	� Prise auxiliaire 12 V
>	�� Combiné radio/CD FM stéréo 12 V, avec port MP3 et 4 haut-parleurs étanche
>	�� 2 sièges baquets avec coussinets relevables, logo Sport et fonctions pivot et 

coulissant
>	� Bain de soleil avec ouverture centrale bâbord intégrée
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	� Certification CE « C »

OPCIONES Y ACCESORIOS

KIT DU CAPITAINE
> Bimini inox
> Taud de cockpit et avant
> Moquettes amovibles
> Sondeur

KIT ÉLÉVATION
> Tour de wake-board avec bimini inox
> Supports de wake

OPTIONS INDIVIDUELLES
> Taud de mouillage, noir et 1 pièce.
> Moquette fine infinity

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	�Motor de popa MerCruiser® ECT 4.5L Alpha® I (200 hp - 149 kW)
>	� Cornamusa personalizada Sea Ray® de acero inoxidable
>	� Revestimiento de gel blanco hielo
>	� Iluminación de navegación - acero inoxidable
>	� Remolque para esquí, acero inoxidable
>	� Plataforma de baño adicional extendida con escalera de baño de acero  

inoxidable de tres peldaños y asidero 
>	� Portabebidas, acero inoxidable
>	� Asideros, acero inoxidable
>	� Accesorio, toma de corriente 12V
>	� Equipo estéreo, 12V FM con lector para un CD y puerto MP3 con altavoces 

resistentes a la intemperie (4)
>	� Asientos giratorios (2), con apoyo abatible para elevar las piernas, función de 

giro y deslizamiento y logotipos deportivos
>	� Solárium con paso de acceso a espejo de popa
> Sistema EC de extinción de incendios - automático con bomba manual
>	� Certificación “C” de la CE

OPCIONES Y ACCESORIOS

PAQUETE CAPTAIN
> Bimini Top
>	Funda de bañera y proa
>	Moqueta en bañera
> Profundimetro

PAQUETE ELEVACION
>	�Torre para deportes acuáticos con Bimini
>	Soporte para tablas de Wake

OPCIONES INDIVIDUALES
> Lona de cierre completa
> Infinity, Woven Cockpit Flooring

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	�MerCruiser® 4.5 MPI Alpha I (200HP - 149 KW)
>	� Kundenspezifische Sea Ray Klampen aus Edelstahl
>	� Gelbeschichtung, Perlmutt
>	� Navigationsleuchten - Edelstahl
>	� Wasserski-Schleppöse, Edelstahl
>	� Badeplattform, zusätzlich erweitert mit dreistufiger Badeleiter aus Edelstahl 

und Haltegriff
>	� Getränkehalter aus Edelstahl
>	� Handgriffe aus Edelstahl
>	� Steckdose, 12V, Zubehör
>	� Stereoanlage, 12V FM Einzel-CD und MP3-Anschluss mit wetterfesten  

Lautsprechern (4)
>	� Schalensitze (2) mit hochklappbaren Schenkelpolstern; Gleit- und  

Schwenkfunktion & Sportlogos
>	� Sonnenliege mit integriertem Heck-Durchgang
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	� CE-Zertifizierung “C”

OPTIONEN UND ZUBEHÖR

CAPTAIN’S-AUSFÜHRUNG
>	�Bimini-Top mit Hülle
>	Sportpersenning und Bugabdeckung
>	Cockpitteppich einknöpfbar
> Echolot

ELEVATION-AUSFÜHRUNG
>	�schwarzer Wakebordtower mit Bimini-Top
>	Wakebordracks

KUNDENSPEZIFISCHE OPTIONEN
>	Vollpersenning
> Infinity Cockpit Bodenbelag, gewebtes Kunstleder

CAPTAIN’S PACKAGE
>	�Bimini Top w/Boot, Stainless 

Steel Bal & Socket Hardware 
>	Canvas, Cockpit and Tonneau Cover 
>	Carpet Liner, Snap-In (Cockpit)
> Depth Finder

ELEVATION PACKAGE
>	�Water Sports Tower Black w/ 

Bimini Top
>	Tower Racks

INDIVIDUAL OPTIONS
>	Mooring Cover, Black
> Infinity, Woven Cockpit Flooring

S E A  R A Y 
S P X ®  1 9 0  O B

FEATURES & STANDARD EQUIPMENT
>	Battery On/Off Switch
>	Cup Holders, Stainless-Steel
>	Depth Finder
>	Driver seat turnable
>	Extra Storage under seats
>	Grab Handles, Stainless-Steel
>	3 Lockable Storage Areas
>	Navigation Lights
>	Outlet, 12V Accessory
>	Reversible backrest port seat 
>	Rub Rail, Black PVC with Stainless Steel Insert
>	Swim Platform, Stainless-Steel, Four-Step Swim Ladder
>	Stereo, 12V AM/FM with Remote Control & Weatherproof Speakers (2)
>	Ski Locker in floor
>	Stainless Steel removable Ski pole

OPTIONS & ACCESSORIES
OPTIONAL ENGINES
> Mercury® 115 EFI FourStroke Inline 4 Outboard Engine (115 hp - 86 kW)
> Mercury® 150 EFI FourStroke Inline 4 Outboard Engine (150 hp - 110 kW)

INDIVIDUAL OPTIONS
> Canvas Pack Incl: Aft Curtain, Front & Side Curtains
>	Mooring Cover, Black
>	Infinity, Woven Cockpit Flooring 
> SeaDek covering on Swim Platform ( Gray or Mocha)
> Premier Stereo w/ extra speakers /  Sub Woofer 
> Mercury Active Trim

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Interrupteur de batterie in Coupe Batterie Casier in Rangement
>	Porte-verres en acier inoxydable
>	Profondimètre
>	Siège pilote pivotant
>	Rangements supplémentaires sous les sièges
>	Poignées en acier inoxydable
>	3 compartiments verrouillables
>	Feux de navigation
>	Prise auxiliaire 12 V
>	Siège bâbord avec dossier réversible
>	Rail de frottement en PVC noir avec insert en acier inoxydable
>	Plate-forme de bain, échelle de bain à quatre marches en acier inoxydable
>	Radio AM/FM stéréo avec télécommande et haut-parleurs étanches (2)
>	Casier à ski dans le sol

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
> Mercury® 115 EFI, hors-bord 4 temps (115 ch - 86 kW)
> Mercury® 150 EFI, hors-bord 4 temps (150 ch - 110 kW)

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	Interruptor de batería On/Off
>	Portabebidas, acero inoxidable
>	Indicador de profundidad
>	Asiento piloto giratorio
>	Espacio de estiba adicional debajo de los asientos
>	Asideros de acero inoxidable
>	Tres espacios de estiba con cerradura
>	Luces de navegación
>	Toma de corriente 12V, Accesorio
>	Asiento de babor con respaldo reversible
>	Listón negro, PVC negro con implante de acero inoxidable
>	Plataforma de baño, acero inoxidable, escalera con cuatro peldaños
>	�Estéreo, 12V AM/FM con mando a distancia y altavoces resistentes  

a la intemperie (2)
> Guarda-esquís en el piso

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
> Motor fueraborda de cuatro tiempos Mercury® 115 EFI (115 hp - 86 kW)
> Motor fueraborda de cuatro tiempos Mercury® 150 EFI (150 hp - 110 kW)

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	Ein-/Aus-Schalter für Batterie
>	Getränkehalter aus Edelstahl
>	Tiefenmesser
>	Drehbarer Steuersitz
>	Zusätzlicher Stauraum unter den Sitzen
>	Handgriffe aus Edelstahl
>	3 geschlossene Stauräume
>	Navigationsleuchten
>	Steckdose, 12V, Zubehör
>	Herunterklappbare Rückenlehne für Backbord-Sitz
>	PVC-Scheuerleiste, schwarz, mit Edelstahleinsatz
>	Badeplattform mit Badeleiter (4 Stufen) aus Edelstahl
>	Stereo, 12V AM/FM mit Fernbedienung & wasserdichten Lautsprechern (2)
>	Staufach für Wasserski im Fußboden

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
> Mercury® 115 EFI 4-Takt-Außenbordmotor (115 PS - 86 kW)
> Mercury® 150 EFI 4-Takt-Außenbordmotor (150 PS -110 kW)

8P / 910 KG

KIT DU CAPITAINE
>	Bimini inox
>	Bain de soleil avant avec dossier 
avant
>	Taud de cockpit et avant
> Moquettes amovibles
> Table de cockpit en polyester
> Sondeur
> Coussin bain de soleil arrière

KIT ÉLÉVATION
>	Tour de wake-board avec bimini inox
>	Supports de wake
>	Mirroir de ski
>	Visière de tableau de bord

KIT SÉLECTION
>	Poste de barre Prémium: finition 
tableau de bord, et chrome
>	Sellerie Premium (Bella Grana 
Spice & Diamante Ivory w/ Carbon 
Accents)
>	Eclairage de cockpit LED bleu

S E A  R A Y 
S P O R T ®  1 9 0 7 P / 545 KG5,99 M | 2,21 M 1.179 KG 98 L 5,94 M | 2,54 M 113 L 1,131 KG

CAPTAIN’S PACKAGE
>	Bimini Top w/Boot, Stainless 
Steel Bal & Socket Hardware 
>	Bow Filler Cushion with forward 
Walk-Thru Backrest cushion
>	�Canvas, Cockpit and Tonneau 

Cover
>	Carpet Liner, Snap-In (Cockpit)
>	Cockpit Table, Fiberglass
>	Depth Finder
>	Sunpad Walk-Thru Cushion 

ELEVATION KIT
>	Water Sports Tower Black w/ 
Bimini Top
>	Tower Racks 
>	Ski Mirror
>	Dash Visor

SELECT PACKAGE
> Helm Upgrades; Vinyl Panels, 
SST Bezels & Visor
> Upholstery Upgrade, Bella Off 
White & Praline 
> Blue Led Lighting Package

OPTIONS INDIVIDUELLES
> Moquette fine infinity
>	Package Fermeture de bimini ( Avant, cotés et arrière)
>	Taud de mouillage, noir et 1 pièce.
>	Sea deck sur plateforme de bain (Grise ou mocha)
> Trim Active Mercury DTS inclus
> Stereo Premium avec des enceintes supplémentaires et caissons de 
basses

PAQUETE CAPTAIN
>	Bimini Top
>	Colchoneta de proa con respaldo 
parte central
> Funda de bañera y proa
> Moqueta en bañera
>	Mesa de bañera
> Profundimetro
>	�Colchoneta paso solarium

PAQUETE ELEVACION
>	Torre para deportes acuáticos 
con Bimini
>	Soporte para tablas de Wake
>	Espejo para esqui
>	dash visor

PAQUETE SELECTO
>	�Puesto de mando mejorado; 

paneles vinilo y acero en biseles y 
visor 

>	Tapiceria Bella y Praline
>	Luces de bañera Led azules

OPCIONES INDIVIDUALES
> Infinity, Woven Cockpit Flooring
>	Cierre c/ toldos a partir de toldo de sol
>	Lona de cierre completa
>	SeaDek- Plataforma de Baño ( Gris o Mocha)
> Trim Active Mercury DTS inclus
> Mejora de estéreo Premier

CAPTAIN’S-AUSFÜHRUNG
>	�Bimini-Top mit Hülle
>	Bugfüllpolster
>	Sportpersenning und 
Bugabdeckung
>	Cockpitteppich einknöpfbar
>	Cockpittisch aus GfK
>	Echolot
>	Füllpolster für die Sonnenliege

ELEVATION-AUSFÜHRUNG
>	schwarzer Wakebordtower mit 
Bimini-Top
> Wakebordracks
>	�Wasserskispiegel
>	Blende für Armaturenbrett

SELECT-AUSFÜHRUNG
>	Höherwertiges Armaturenbrett 
mit Lederverkleidung und 
Chromringen an den Anzeigen
>	�Wahlweise Polsterung in Bella 

grana praline (beige/braun)
>	Blaues LED-Lichtpaket

KUNDENSPEZIFISCHE OPTIONEN
> Infinity Cockpit Bodenbelag, gewebtes Kunstleder
>	Verdeckpaket für Bimini-Top
>	Vollpersenning
>	Seadek Belag auf der Badeplattform
> Trim Active Mercury DTS inclus
> Premium Stereosystem mit Subwoofer

8 3
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FEATURES & STANDARD EQUIPMENT
>	MerCruiser® ECT 4.5 MPI Alpha I Sterndrive (200 hp - 149 kW)
>	Battery On/Off Switch
>	Cup Holder, Stainless-Steel
>	Depth Finder
>	Driver seat turnable
>	Extra Storage under seats
>	Grab Handles, Stainless-Steel
>	3 Lockable Storage Areas
>	Navigation Lights
>	Outlet, 12V Accessory
>	Reversible backrest port seat 
>	Rub Rail, Black PVC w/Stainless Steel Insert
>	Stereo, 12V AM/FM with Remote Control & Weatherproof Speakers (2)
>	Ski Locker in floor
> CE Fire Suppression System - automatic 
>	Swim Platform, Four-Step Swim Ladder

OPTIONS & ACCESSORIES

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Moteur mixte MerCruiser® 4.5 MPI Alpha I (200 ch - 149 kW)
>	�Interrupteur de batterie in Coupe Batterie Casier in Rangement
>	Porte-verres en acier inoxydable
>	Profondimètre
>	Siège pilote pivotant
>	Rangements supplémentaires sous les sièges
>	Poignées en acier inoxydable
>	3 compartiments verrouillables
>	Feux de navigation
>	Prise auxiliaire 12 V
>	Siège bâbord avec dossier réversible
>	Rail de frottement en PVC noir avec insert en acier inoxydable
>	Radio AM/FM stéréo avec télécommande et haut-parleurs étanches (2)
>	Casier à ski dans le sol
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Plate-forme de bain avec échelle de bain à quatre marches

OPTIONS & ACCESSOIRES

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motor de popa* MerCruiser 4,5 l MPI Alpha I (200 hp - 149 kW)
>	Interruptor de batería On/Off
>	Portabebidas, acero inoxidable
>	Indicador de profundidad
>	Asiento piloto giratorio
>	Espacio de estiba adicional debajo de los asientos
>	Asideros, acero inoxidable
>	Tres espacios de estiba con cerradura
>	Luces de navegación
>	Toma de corriente 12V, Accesorio
>	Asiento de babor con respaldo reversible
>	Listón negro, PVC negro con implante de acero inoxidable
>	�Estéreo, 12V AM/FM con mando a distancia y altavoces resistentes  

a la intemperie (2)
>	Guarda-esquís en el piso
> Sistema EC de extinción de incendios - automático con bomba manual
>	Plataforma de baño, escalera con cuatro peldaños

OPCIONES Y ACCESORIOS

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	MerCruiser® 4,5 l MPI Alpha I Heckantrieb (200 PS - 149 kW)
>	Ein-/Aus-Schalter für Batterie
>	Getränkehalter aus Edelstahl
>	Tiefenmesser
>	Drehbarer Steuersitz
>	Zusätzlicher Stauraum unter den Sitzen
>	Handgriffe aus Edelstahl
>	3 geschlossene Stauräume
>	Navigationsleuchten
>	Steckdose, 12V, Zubehör
>	Herunterklappbare Rückenlehne für Backbord-Sitz
>	PVC-Scheuerleiste, schwarz, mit Edelstahleinsatz
>	Stereo, 12V AM/FM mit Fernbedienung & wasserdichten Lautsprechern (2)
>	Staufach für Wasserski im Fußboden
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	Badeplattform, Badeleiter mit 4 Stufen

OPTIONEN UND ZUBEHÖR

8 P / 695 KG
S E A  R A Y 
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FEATURES & STANDARD EQUIPMENT
>	MerCruiser® ECT 4.5 MPI Alpha I Sterndrive (200 hp - 149 kW)
>	Battery On/Off Switch
>	Cup Holders, Stainless Steel
>	Depth Finder
>	Driver seat turnable
>	Extra Storage under seats
>	Grab Handles, Stainless Steel
>	3 Lockable Storage Areas
>	Navigation Lights
>	Outlet, 12V Accessory
>	Rub Rail, Black PVC w/Stainless Steel Insert
>	Reversible backrest port seat
>	Ski Locker in floor
>	Stereo, 12V AM/FM w/Remote Control & Weatherproof Speakers (2)
> CE Fire Suppression System
>	Swim Platform, Integral Four-Step Swim Ladder

OPTIONS & ACCESSORIES
OPTIONAL ENGINES  
> MerCruiser® ECT 4.5 MPI Alpha I Sterndrive (250 hp - 188 kW)
>	�Non ECT engines available outside EU
 

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Moteur mixte MerCruiser® 4.5 MPI Alpha I (200 ch - 149 kW)
>	Interrupteur de batterie in Coupe Batterie Casier in Rangement
>	Porte-verres en acier inoxydable
>	Profondimètre
>	Siège pilote pivotant
>	Rangements supplémentaires sous les sièges
>	Poignées en acier inoxydable
>	3 compartiments verrouillables
>	Feux de navigation
>	Prise auxiliaire 12 V
>	Rail de frottement en PVC noir avec insert en acier inoxydable
>	Siège bâbord avec dossier réversible
>	Casier à ski dans le sol
>	Radio AM/FM stéréo avec télécommande et haut-parleurs étanches (2)
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Plate-forme de bain avec échelle de bain intégrale à quatre marches

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
> Moteur mixte MerCruiser® 4.5 MPI Alpha I (250 ch - 188 kW)
> Moteurs non-ECT disponibles en dehors de l’UE

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	Motor de popa* MerCruiser 4,5 l MPI Alpha I (200 hp - 149 kW)
>	Interruptor de batería On/Off
>	Portabebidas, acero inoxidable
>	Indicador de profundidad
>	Asiento piloto giratorio
>	Espacio de estiba adicional debajo de los asientos
>	Asideros, acero inoxidable
>	Tres espacios de estiba con cerradura
>	Luces de navegación
>	Toma de corriente 12V, Accesorio
>	Listón negro, PVC negro con implante de acero inoxidable
>	Asiento de babor con respaldo reversible
>	Guarda-esquís en el piso
>	�Estéreo, 12V AM/FM con mando a distancia y altavoces resistentes  

a la intemperie (2)
> Sistema EC de extinción de incendios - automático con bomba manual
>	Plataforma de baño, integral, escalera con cuatro peldaños

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
> Motor de popa* MerCruiser 4,5 l MPI Alpha I (250 hp - 188 kW)
> Motores sin ECT disponibles fuera de la UE

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	MerCruiser® 4,5 l MPI Alpha I Heckantrieb (200 PS - 149 kW)
>	Ein-/Aus-Schalter für Batterie
>	Getränkehalter aus Edelstahl
>	Tiefenmesser
>	Drehbarer Steuersitz
>	Zusätzlicher Stauraum unter den Sitzen
>	Handgriffe aus Edelstahl
>	3 geschlossene Stauräume
>	Navigationsleuchten
>	Steckdose, 12V, Zubehör
>	PVC-Scheuerleiste, schwarz, mit Edelstahleinsatz
>	Herunterklappbare Rückenlehne für Backbord-Sitz
>	Staufach für Wasserski im Fußboden
>	Stereo, 12V AM/FM mit Fernbedienung & wasserdichten Lautsprechern (2)
>	Badeplattform, integrierte Badeleiter mit 4 Stufen
> CE-Feuerlöschsystem - automatisch mit manuellem Zug

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
> MerCruiser® 4,5 l MPI Alpha I Heckantrieb (250 PS - 188 kW)
> Nicht-ETC-Motoren außerhalb der EU verfügbar

10 P / 818 KG

CAPTAIN’S PACKAGE
> Bimini Top w/Boot, Stainless 
Steel Bal & Socket Hardware 
> Bow Filler Cushion with forward 
> Walk-Thru Backrest cushion
> Canvas, Cockpit and Tonneau 
Cover 
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Table, Fiberglass
> Sunpad Walk-Thru Cushion 

ELEVATION PACKAGE
> Water Sports Tower Black w/ 
Bimini Top
> Tower Racks 
> Ski Mirror
> Dash Visor

SELECT PACKAGE
> Helm Upgrades; Vinyl Panels, 
SST Bezels & Visor
> Upholstery Upgrade, Bella Off 
White & Praline 
> Blue Led Lighting Package

CAPTAIN’S PACKAGE
> Bimini Top w/Boot, Stainless 
Steel Bal & Socket Hardware 
> Bow Filler Cushion with forward 
Walk-Thru Backrest cushion
> Canvas, Cockpit and Tonneau 
Cover 
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Table, Fiberglass
> Depth Finder
> Sunpad Walk-Thru Cushion 

ELEVATION PACKAGE
>	Ski Mirror
>	�Tower, Watersports with Bimini
>	Tower Racks
>	Dash Visor

SELECT PACKAGE
>	Additional cushions and bolsters
>	Helm Upgrade: Vinyl Panels
>	�LED Lighting Package, Blue
>	�Luxury Upholstery, Bella Grana 

Off White & Praline 
(Viper Swan & Flint as a no 
charge option)

KIT DU CAPITAINE
> Bimini inox
> Bain de soleil avant avec dossier 
avant
> Taud de cockpit et avant
> Moquettes amovibles
> Table de cockpit en polyester
> Sondeur
> Coussin bain de soleil arrière

KIT ÉLÉVATION
> Tour de wake-board avec bimini inox
> Supports de wake
> Mirroir de ski
> Visière de tableau de bord

KIT SÉLECTION
> Poste de barre Prémium: finition 
tableau de bord, et chrome
> Sellerie Premium (Bella Grana 
Praline & Diamante Ivory w/ 
Carbon Accents)
> Eclairage de cockpit LED bleu

5,94 M | 2,54 M 113 L 1.350 KG 6,55 M | 2,54 M 151 L 1.542 KG

INDIVIDUAL OPTIONS
>	Mooring Cover, Black
> Infinity, Woven Cockpit Flooring
> SeaDek covering on Swim Platform ( Gray or Mocha)
> Premier Stereo w/ extra speakers /  Sub Woofer

OPTIONS INDIVIDUELLES
> Package Fermeture de bimini ( Avant, cotés et arrière)
> Moquette fine infinity
> Taud de mouillage, noir et 1 pièce.
> Sea deck sur plateforme de bain (Grise ou mocha)
> Stereo Premium avec des enceintes supplémentaires et caissons de 
basses

PAQUETE CAPITÁN
> Bimini Top
> Colchoneta de proa con respaldo 
parte central
> Funda de bañera y proa
> Moqueta en bañera
> Mesa en bañera
> Profundimetro
> Colchoneta paso solarium

PAQUETE DE ELEVACIÓN
> Torre para deportes acuáticos 
con Bimini
> Soporte para tablas de Wake
> Espejo para esqui
> dash visor

PAQUETE SELECTO
> Puesto de mando mejorado; 
paneles vinilo y acero en biseles 
y visor 
> Tapiceria Bella y Praline
> Luces de bañera Led azules

OPCIONES INDIVIDUALES
> Cierre c/ toldos a partir de toldo de sol
> Lona de cierre completa
> SeaDek- Plataforma de Baño ( Gris o Mocha)
> Mejora de estéreo Premier

CAPTAIN'S-AUSFÜHRUNG
> Bimini-Top mit Hülle
> Bugfüllpolster
> Sportpersenning und 
> Bugabdeckung
> Cockpitteppich einknöpfbar
> Cockpittisch aus GfK
> Echolot
> Füllpolster für die Sonnenliege

ELEVATION-AUSFÜHRUNG
> Schwarzer Wakebordtower mit 
> Bimini-Top
> Wakebordracks
> Wasserskispiegel
> Blende für Armaturenbrett

SELECT-AUSFÜHRUNG
> Höherwertiges Armaturenbrett 
mit Lederverkleidung und 
Chromringen an den Anzeigen
> wahlweise Polsterung in Bella
 > grana praline (beige/braun)
blaues LED-Lichtpaket

KUNDENSPEZIFISCHE OPTIONEN
> Verdeckpaket für Bimini-Top
> Infinity Cockpit Bodenbelag, gewebtes Kunstleder
> Vollpersenning
> Seadek Belag auf der Badeplattform
> Premium Stereosystem mit Subwoofer INDIVIDUAL OPTIONS

> Canvas Pack Incl: Aft Curtain, Front & Side Curtains
> Mooring Cover, Black
> Infinity, Woven Cockpit Flooring 
> SB Bucket Seat with PS  Reversible Loungeseat 
> SeaDek covering on Swim platform ( Gray or Mocha)
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Premier Stereo w/ extra speakers /  Sub Woofer

KIT DU CAPITAINE
> Bimini inox
> Bain de soleil avant avec dossier 
avant
Taud de cockpit et avant
> Moquettes amovibles
> Table de cockpit en polyester
> Coussin bain de soleil arrière

KIT ÉLÉVATION
> Tour de wake-board avec bimini inox
> Supports de wake
> Mirroir de ski
> Visière de tableau de bord

KIT SÉLECTION
> Poste de barre Prémium: finition 
tableau de bord, et chrome
> Sellerie Premium (Bella Grana 
Spice & Diamante Ivory w/ Carbon 
Accents)
> Eclairage de cockpit LED bleu

OPTIONS INDIVIDUELLES
> Package Fermeture de bimini ( Avant, cotés et arrière)
> Taud de mouillage, noir et 1 pièce.
> Moquette fine infinity
> Assise passager babord reversible
> Sea deck sur plateforme de bain (Grise ou mocha)
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Stereo Premium avec des enceintes supplémentaires et caissons de 
basses

PAQUETE CAPITÁN
> Bimini Top
> Colchoneta de proa con respaldo 
> Parte central
> Funda de bañera y proa
> Moqueta en bañera
> Mesa en bañera
> Colchoneta paso solarium

PAQUETE DE ELEVACIÓN
> Torre para deportes acuáticos 
con Bimini
> Soporte para tablas de Wake
> Espejo para esqui
> dash visor

PAQUETE SELECTO
> Puesto de mando mejorado; 
paneles vinilo y acero en biseles 
y visor 
> Tapiceria Bella y Praline
> Luces de bañera Led azules

OPCIONES INDIVIDUALES
> Cierre c/ toldos a partir de toldo de sol
> Lona de cierre completa
> Asiento babor reversible
> SeaDek- Plataforma de Baño ( Gris o Mocha)
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Mejora de estéreo Premier

CAPTAIN'S-AUSFÜHRUNG
> Bimini-Top mit Hülle
> Bugfüllpolster
> Sportpersenning und 
Bugabdeckung
> Cockpitteppich einknöpfbar
> Cockpittisch aus GfK
Füllpolster für die Sonnenliege

ELEVATION-AUSFÜHRUNG
> Schwarzer Wakebordtower mit 
Bimini-Top
> Wakebordracks
> Wasserskispiegel
> Blende für Armaturenbrett

SELECT-AUSFÜHRUNG
> Höherwertiges Armaturenbrett 
mit Lederverkleidung und 
Chromringen an den Anzeigen
> wahlweise Polsterung in Bella 
> Grana praline (beige/braun)
> Blaues LED-Lichtpaket

KUNDENSPEZIFISCHE OPTIONEN
> Verdeckpaket für Bimini-Top
> Vollpersenning
> Infinity Cockpit Bodenbelag, gewebtes Kunstleder
> umklappbarer Beifahrersitz / Sitzbank
> Seadek Belag auf der Badeplattform
> GPS-Kartenplotter mit Fischfinder 5”
> digitales Armaturenbrett mit Merc. Vesselview Anbindung
> Premium Stereosystem mit Subwoofer
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FEATURES & STANDARD EQUIPMENT
>	Mercruiser® ECT 4.5 MPI Alpha® I Sterndrive (250 hp - 188 kW)
>	Battery On/Off Switch
>	Cup Holder, Stainless-Steel
>	Depth Finder
>	Extra Storage under seats
>	Grab Handles, Stainless-Steel
>	3 Lockable Storage Areas
>	Navigation Lights
>	Outlet, 12V Accessory
>	Bucket Seats (2), w/Flip-Up Thigh Rise, Swivel & Slider Functions
>	Rub Rail, Black PVC w/Stainless Steel Insert
>	Stereo, 12V AM/FM with Remote Control & Weatherproof Speakers (2)
>	Ski Locker in floor
> CE Fire Suppression System - automatic w/manual pull
>	Swim Platform, Four-Step Swim Ladder

OPTIONS & ACCESSORIES 
OPTIONAL ENGINES  
> Mercruiser® ECT 4.5 MPI Bravo® III Sterndrive (250 hp - 188 kW)
> Mercruiser ECT 4.5L MPI Bravo® III w/DTS* Sterndrive (250 php - 188 kW)
> Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (300 php - 224 kW)
>	�Non ECT engines available outside EU

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motor de popa* MerCruiser 4,5 l MPI Alpha I (250 hp - 188 kW)
>	Interruptor de batería On/Off
>	Portabebidas, acero inoxidable
>	Indicador de profundidad
>	Espacio de estiba adicional debajo de los asientos
>	Asideros, acero inoxidable
>	Tres espacios de estiba con cerradura
>	Luces de navegación
>	Toma de corriente 12V, Accesorio
>	Asientos giratorios (2), con apoyo abatible para elevar las piernas, función 
de giro y deslizamiento y logotipos deportivos
>	Listón negro, PVC negro con implante de acero inoxidable
>	�Estéreo, 12V AM/FM con mando a distancia y altavoces resistentes  

a la intemperie (2)
>	Guarda-esquís en el piso
> Sistema EC de extinción de incendios - automático con bomba manual
>	Plataforma de baño, escalera con cuatro peldaños

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
> Motor de popa MerCruiser® ECT 4.5 MPI Bravo® III (250 hp - 188 kW)
> Motor de popa MerCruiser ECT 4,5 l MPI Bravo® III con DTS* (250 hp - 188 kW)
> Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (300 hp - 224 kW) 
>	�Motores sin ECT disponibles fuera de la UE

13 P / 1038 KG

PAQUETE CAPITÁN
> Bimini Top
> Colchoneta de proa con respaldo 
> Parte central
> Funda de bañera y proa
> Moqueta en bañera
> Mesa en bañera
> Colchoneta paso solarium

PAQUETE DE ELEVACIÓN
> Torre para deportes acuáticos 
con Bimini
> Soporte para tablas de Wake
> Espejo para esqui
> Dash visor

7.01 M | 2,54 M 189 L 1.983 KG
S E A  R A Y 
S L X ®  2 5 0 2.567 KG 12P / 968 KG246 L7,55 M | 2,59 M

FEATURES & STANDARD EQUIPMENT
>	Mercruiser ECT 4.5L MPI Bravo® III w/DTS* Sterndrive (250 php - 188 kW)
>	�CE Option Group
>	�Bimini Top w/boot 
>	� Integrated swim platform w/recessed stainless-steel four step swim ladder
>	�Cockpit table, fiberglass
>	�Bow lounger seats w/flip-down armrests & storage below
>	�Enclosed head compartment w/fiberglass lockable door and portable head
>	�Helm bench seat w/slider,flip-up thigh-rise bolster & fiberglass base
>	�Beverage holders, stainless steel
>	� Stereo, 12V AM/FM, Wireless Bluetooth™, Dual Zone Volume Control, 

Amplifier & Weatherproof Speakers 
>	� Storage, Side Panel - upper & lower
>	�Battery On/Off Switch 
>	� CE Fire Suppression System - automatic w/manual pull
>	�� Color Coordinated Vinyls w/Diamond Pattern and Accent Vinyls:  

Sand (Pearl) with Sterling snap-in carpet liner

OPTIONS & ACCESSORIES
OPTIONAL ENGINES  
>	� Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (300 php - 224 kW)
>	�Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (350 php - 261 kW)
> Mercury Diesel TDI 3.0L 265 DTS Bravo llx Sterndrive (265 hp - 198 KW)
>	�Non ECT engines available outside EU

CAPTAIN’S PACKAGE
> Canvas, Cockpit and Tonneau Cover 
> Cockpit Shower on Transom 
> Docking Lights 
> Windshield Wiper Starboard

ELEVATION PACKAGE
> Water Sports Tower Black w/ 
Bimini Top
> Swivel Wakeboard Racks
> Ski Mirror
> Air Compressor for Water Toys

SELECT PACKAGE
> Bow Filler Cushion 
> Bow Cockpit Table
> Cockpit table, Teak with Filler 
Cushions (replaces fiberglass table)

INDIVIDUAL OPTIONS
> Bottom Paint
> Submersible Swimplatform, Manual 
Operated
> Trim Tabs, Hydraulic
> Under Water Lights, Through Hull
> Bow ladder Hatch (not with Anchor 
Winch)

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
> Moteur mixte MerCruiser ECT 4.5L MPI Bravo® III avec DTS* (250 ch - 188 kW)
>	� Groupe option CE
>	� Taud Bimini avec coffre
>	�� Plate-forme de bain intégrée avec échelle de bain à quatre marches en acier 

inoxydable encastrée
>	� Table de cockpit en fibre de verre
>	� Banquette avant avec accoudoirs rabattables et rangement en dessous
>	�� Compartiment toilettes fermé avec porte verrouillable en fibre de verre et  

WC portable
>	�� Banquette du poste de pilotage avec fonctions pivot et coulisseau et base en 

fibre de verre
>	� Porte-verres en acier inoxydable
>	�� Radio AM/FM stéréo 12 V, Bluetooth™ sans fil, commande du volume bizone, 

amplificateur et haut-parleurs résistants aux intempéries 
>	� Rangements latéraux en parties haute et basse
>	�� Interrupteur de batterie 
>	� Système de lutte incendie CE automatisé avec déclenchement manuel
>	�� Vinyles assortis avec motif à losanges et accent vinyle : sable (perle) avec 

revêtement tapis enfichable Sterling

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
>	�� Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (300 ch - 224 kW)
>	�� Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (350 ch - 261 kW)
> Moteur diesel TDI® Mercury® 3.0L 265 DTS Bravo® IIIx (265 ch - 198 kW)
>	� Moteurs non-ECT disponibles en dehors de l’UE

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motor de popa MerCruiser ECT 4,5 l MPI Bravo® III con DTS* (250 hp - 188 kW)
> Opción Grupo EC
> Toldo Bimini con funda
>	� Plataforma de baño integral con escalera empotrada de cuatro peldaños de 

acero inoxidable
>	� Mesa de la bañera, de fibra de vidrio
>	� Asientos de proa con reposabrazos abatibles y espacio de almacenamiento 

debajo
>	� Cuarto de baño con puerta de fibra de vidrio con cierre e inodoro portátil
>	� Asiento de timón con apoyo abatible para elevar las piernas, deslizable y base 

de fibra de vidrio
>	� Portabebidas, acero inoxidable
>	� Equipo estéreo, 12V AM/FM, Bluetooth™ inalámbrico, control del volumen dual, 

amplificador y altavoces resistentes a la intemperie
>	� Espacio de almacenamiento, panel lateral - superior e inferior
>	� Interruptor encendido/apagado batería 
>	� Sistema EC de extinción de incendios - automático con bomba manual
>	� Vinilos en colores a juego con patrón de diamantes y detalles de vinilo: arena 

(perla) con protector de moqueta a corchetes

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
> �Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (300 hp - 224 kW)
> Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (350 hp - 261 kW)
> Motor de popa Mercury® Diesel TDI® 3,0L 265 DTS Bravo® IIIx (265 hp- 198 kW)
>	� Motores sin ECT disponibles fuera de la UE

KIT DU CAPITAINE
> Taud de cockpit et avant
> Douchette sur tableau arrière
> Feu d’approche
> Essui glace tribord

KIT ÉLÉVATION
> Tour de wake-board Noir avec 
 bimini inox
> Supports de wake
> Mirroir de ski
> Compresseur à air pour accessoires 
gonflables

KIT SÉLECTION
> Coussin avant pour bain de soleil
> Coussin table de cockpit
> Table de cockpit en teck (remplace 
celle en polyester)

OPTIONS INDIVIDUELLES
> Antifouling usine
> Plateforme de bain submersible 
manuellement
> Commandes trim sur tableau 
arrière
> Lumières sous plateforme de bain
> Coffre échelle de bain avant (non 
dispo quand Guindeau)

> Guindeau éléctrique avec chaîne et 
ancre en inox
> Package Fermeture de bimini ( 
Avant, cotés et arrière)
> Taud de cockpit,avant
> Taud de mouillage, noir et 1 pièce.
> Douchette avant pour rinçage
> Moquette fine infinity
> Chauffage de cockpit de la calle moteur
> Douchette de cockpit
> Table de cockpit polyester avec 
recouvrement teck
> Eau chaude
> Package Led dans le Cockpit- bleu 
ou blanc
> Réfrigérateur (12 volts) dans le Cockpit
> Sea deck sur plateforme de bain 
(Grise ou mocha)
> Cockpit recouvert de teck ( Rem-
place les moquettes)
> Teck sur plateforme de bain
WC chimique avec réservoir et 
macérateur
> Stereo Premium avec des enceintes 
supplémentaires et caissons de 
basses
> Commande Trim sur tableau arrière
> Chargeur de batterie 

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	� MerCruiser® ECT 4,5 l MPI Bravo® III mit DTS* Heckantrieb (250 PS - 188 kW)
>	� CE-Optionsgruppe
>	� Bimini-Verdeck mit Hülle
>	� Integrierte Badeplattform mit versenkter Badeleiter (4 Stufen) aus Edelstahl
>	� Cockpit-Tisch, Fiberglas
>	� Bug-Liegesitze mit herunterklappbaren Armlehnen und Stauraum darunter
>	� Geschlossene Nasszelle mit verschließbarer Tür aus Fiberglas und  

tragbarem WC
>	� Steuerstandbank mit Gleitfunktion, hochklappbarem Schenkelpolster und 

Fiberglasbasis
>	� Getränkehalter aus Edelstahl
>	� Stereo, 12V AM/FM, Wireless Bluetooth™, Dualzonen-Lautstärkeregler, Verstä-

rker und wetterfeste Lautsprecher
>	� Stauraum, Seitenwand – oben und unten
>	� Batterie Ein/Aus-Schalter - abgesetzter Batterieschalter am Steuerstand
>	� CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	� Abgestimmte Vinylfarben mit Diamantmuster und farblichen Akzenten:  

Sand (Perlmutt) mit einknöpfbarem Sterling-Fußbodenbelag

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
>	� MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (300 PS - 224 kW)
>	� MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (350 PS - 261 kW)
> Mercury® Diesel TDI® 3,0 l 265 DTS Bravo® IIIx Heckantrieb (265 PS - 198 kW)
>	� Nicht-ETC-Motoren außerhalb der EU verfügbar

CAPTAIN'S-AUSFÜHRUNG
> Sportpersenning und Bugab-
deckung
> Heckdusche
> Docking Lights (Leuchten im Bug)
 Scheibenwischer stb.

ELEVATION-AUSFÜHRUNG
> Sportpersenning und Bugab-
deckung
> Heckdusche
> Docking Lights (Leuchten im Bug)
 Scheibenwischer stb.

SELECT-AUSFÜHRUNG
> Bugfüllpolster
> Cockpittisch im Bug
> Cockpittisch aus Teak

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Manuelle Unterwasserplattform
> Hydraulische Trimklappen
> Unterwasserbeleuchtung durch 
den Rumpf
> Bugbadeleiter (nicht bestelbar bei 
Elektrischer Ankerwinde)

> Elektrische Ankerwinde mit Kette 
und edelstahlanler
> Verdeckpaket für Bimini-Top
> Sportpersenning
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Vollpersenning
> Deckwaschanschluss Bug
> Cockpitheizung über den Motor
> Heckdusche
> Cockpittisch aus GfK
> Heißwassersystem
> Blaues oder weißes LED-Lichtpaket
> Cockpitkühlschrank (12 V)
> Seadek-Boden auf der Badeplat-
tform
> Teakboden im Cockpit
> Teak auf der Badeplattform
> Elektrisches Marine-WC, Fäkalien-
tank und Fäkalienpumpe
> Premium Stereosystem mit 
Subwoofer
> Trim- / Tiltschalter am Heck
> Onboard Batterieladegerät

PAQUETE CAPITÁN
> Fundas para Bañera y Proa
> Ducha popa bañera
> Luces de atraque
> Limpiaparabrisas Estribor

PAQUETE DE ELEVACIÓN
> Torre de deportes Negra c/ toldos 
Bimini
> Soportes giratorios para tablas 
de esquí
> Espejo esqui
> Compresor de Aire para

PAQUETE SELECTO
> Colchoneta de proa
> Mesa de proa 
> Mesa bañera de teca (substituye la 
mesa de fibra)

OPCIONES INDIVIDUALES
> Pintura de fondos
> Plataforma de Baño Sumergible, 
Manual
> Flaps hidráulicos

> Luces del casco
> Escalera de baño en proa
> Molinete con ancla de Acero
> Conjunto de Toldos  Incl: Toldos de 
Popa, Frontales  y Laterales
> Funda de bañera
> Lona de fondeo
> Salida de agua en proa
> En bañera de motor
> Ducha en popa
> Mesa en bañera de teka
> Calefactor de agua
> Conjunto Led en Bañera:
> Nevera en bañera de 12v
> SeaDeck para la plataforma de baño 
(Gris o Mocha)
> Teca en bañera
> Teca en plataforma de baño
> WC con tanque de retenciones y 
Macerador
> Estereo Premium
> Mando en popa para trim
> Cargador de bateria

> Canvas, Cockpit Cover 
> Mooring Cover, Black 
> Bow Washdown
> Cockpit Heater from engine
> Cockpit Shower
> Cockpit Table, Teak 
> Hot Water - Heat Exchanger
> Infinity, Woven Cockpit Flooring 
> Led Package in Cockpit - Blue 
or White
> Refrigerator (12 volt) in Cockpit
> SeaDek covering on Swim 
plfatorm (Gray or Mocha) 
> Teak Cockpit Upgrade to replace 
Carpet
> Teak On Swim Platform
> Toilet - Electric with holding tank 
and Macerator
> Windlass - Electric with Chain & 
SST Anchor 
> Canvas Pack: Incl: Aft Curtain, 
Front & Side Curtains
> Premier Stereo w/ extra speakers 
and SW & Transom remote
> Transom Remote Trim Switch
> Battery Charger

INDIVIDUAL OPTIONS
> Bottom Paint
> Submersible Swim platform, Manual Operated
> Canvas Pack Incl: Aft Curtain, Front & Side Curtains
> Mooring Cover, Black
> Air Compressor
> Cockpit Table, Teak 
> Cockpit Coolbox
> Infinity, Woven Cockpit Flooring 
> Led Package in Cockpit - Blue or White
> Refrigerator (12 volt) in Cockpit
> SB Bucket Seat with Port side  Reversible Loungeseat 
> SeaDek covering on Swim platform ( Gray or Mocha)
> Toilet - Portable  
> Toilet - Portable with Deck Pump-Out
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Premier Stereo w/ extra speakers /  SW & Transom remote 
> Transom Remote, Stereo
> Transom Trailer Trim Switch
> On Board Battery Charger

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Moteur mixte MerCruiser® 4.5 MPI Alpha I (250 ch - 188 kW)
>	�Interrupteur de batterie in Coupe Batterie Casier in Rangement
>	Porte-verres en acier inoxydable
>	Profondimètre
>	Rangements supplémentaires sous les sièges
>	Poignées en acier inoxydable
>	3 compartiments verrouillables
>	Feux de navigation
>	Prise auxiliaire 12 V
>	2 sièges baquets avec coussinets relevables
>	Rail de frottement en PVC noir avec insert en acier inoxydable
>	Radio AM/FM stéréo avec télécommande et haut-parleurs étanches (2)
>	Casier à ski dans le sol
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Plate-forme de bain avec échelle de bain à quatre marches

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
> Moteur mixte MerCruiser® ECT 4.5 MPI Bravo® III (250 ch – 188 kW)
> Moteur mixte MerCruiser ECT 4.5L MPI Bravo® III avec DTS* (250 ch - 188 kW)
> Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (300 ch - 224 kW)
>	�Moteurs non-ECT disponibles en dehors de l’UE

KIT DU CAPITAINE
> Bimini inox
> Bain de soleil avant avec dossier avant
> Taud de cockpit et avant
> Moquettes amovibles
> Table de cockpit en polyester
> Coussin bain de soleil arrière

KIT ÉLÉVATION
> Tour de wake-board avec 
bimini inox
> Supports de wake
> Mirroir de ski
> Visière de tableau de bord

OPTIONS INDIVIDUELLES
> Peinture coque couleur dessous
> Plateforme de bain submersible manuellement
> Package Fermeture de bimini ( Avant, cotés et arrière)
> Taud de mouillage, noir et 1 pièce.
> Compresseur d’air
> Table de cockpit teck
> Glacière dans cockpit
> Package Led dans le Cockpit- bleu ou blanc
> Moquette fine infinity
> Réfrigérateur (12 volts) dans le Cockpit
> Assise passager babord reversible
> Sea deck sur plateforme de bain (Grise ou mocha)
> WC Chimique portable
> WC Chimique avec évacuation
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Stereo Premium avec des enceintes supplémentaires et caissons de 
basses
> Commande pour stereo sur Tableau arrière
> Commande Trim sur tableau arrière
> Chargeur de batterie embarqué

OPCIONES INDIVIDUALES
> Pintura de fondos
> Plataforma de Baño Sumergible, Manual
> Cierre c/ toldos a partir de toldo de sol
> Lona de cierre completa
> Compresor de aire 
> Mesa en bañera de Teka
> Coolbox 
> Cargador de bateria
> Conjunto luces Led : Azul o blanco
> Nevera en bañera (12v)
> Asiento babor reversible
> SeaDek- Plataforma de Baño ( Gris o Mocha)
> Wc portatil
> Wc portatil con descarga
> Chart Plotter c/ GPS
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Mejora de estéreo Premier
> Control Remoto Popa para estereo
> Trim en popa

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	MerCruiser® 4,5 l MPI Alpha I Heckantrieb (250 PS - 188 kW)
>	Ein-/Aus-Schalter für Batterie
>	Getränkehalter aus Edelstahl
>	Tiefenmesser
>	Zusätzlicher Stauraum unter den Sitzen
>	Handgriffe aus Edelstahl
>	3 geschlossene Stauräume
>	Navigationsleuchten
>	Steckdose, 12V, Zubehör
>	Schalensitze (2) mit hochklappbaren Schenkelpolstern; Gleit- und
Schwenkfunktion
>	PVC-Scheuerleiste, schwarz, mit Edelstahleinsatz
>	Stereo, 12V AM/FM mit Fernbedienung & wasserdichten Lautsprechern (2)
>	Staufach für Wasserski im Fußboden
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	Badeplattform, Badeleiter mit 4 Stufen

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
> MerCruiser® ECT 4,5 l MPI Bravo® III Heckantrieb (250 PS - 188 kW)
> MerCruiser® ECT 4,5 l MPI Bravo® III mit DTS* Heckantrieb (250 PS - 188 kW)
> MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (300 PS - 224 kW) 
>	�Nicht-ETC-Motoren außerhalb der EU verfügbar

CAPTAIN'S-AUSFÜHRUNG
> Bimini-Top mit Hülle
> Bugfüllpolster
> Sportpersenning und
Bugabdeckung
> Cockpitteppich einknöpfbar
> Cockpittisch aus GfK
> Füllpolster für die Sonnenliege

ELEVATION-AUSFÜHRUNG
Schwarzer Wakebordtower mit 
Bimini-Top
Wakebordracks
Wasserskispiegel
Blende für Armaturenbrett

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Manuelle Unterwasserplattform
> Verdeckpaket für Bimini-Top
> Vollpersenning
> Luftkompressor
> Cockpitteisch aus Teak
> Kühlschrank im Cockpit
> Infinity Cockpit Bodenbelag, gewebtes Kunstleder
> Blaues oder weißes LED-Lichtpaket
> Kühlschrank im Cockpit (12V)
> Umklappbarer Beifahrersitz / Sitzbank
> Seadek Belag auf der Badeplattform
> Chemie-WC (Porta Potti)
> Chemie-WC mit Decksabsaugung
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview Link 9”
> Premium Stereosystem mit Subwoofer
> Fernbedienung für die Stereoanlage am Heck
> Trim- / Tiltschalter am Heck
> Onboard Batterieladegerät

CAPTAIN’S PACKAGE
> Bimini Top w/Boot, Stainless Steel Bal 
& Socket Hardware 
> Bow Filler Cushion with forward Walk-
Thru Backrest cushion
> Canvas, Cockpit and Tonneau Cover 
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Table, Fiberglass
> Sunpad Walk-Thru Cushion  

ELEVATION PACKAGE
> Water Sports Tower Black w/  
Bimini Top
> Tower Racks 
> Ski Mirror
> Dash Visor
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S E A  R A Y 
S D X ®  2 7 0 12 P / 950 KG

FEATURES & STANDARD EQUIPMENT
>	�Mercruiser® ECT 6.2 MPI Bravo® III w/DTS Sterndrive (300 hp - 224 kW)
>	�Bimini Top w/boot
>	�Canvas Cockpit Cover w/Tonneau Cover
>	�Swim platform w/recessed stainless-steel four step swim ladder bolt on
>	�Ski tow eye-transom - flush mount
>	�Color Coordinated Vinyls w/Diamond Pattern and Accent Vinyls: Sand 

(Pearl) with Sterling snap-in carpet liner
>	�Cockpit table, fiberglass
>	�Bow lounger seats w/hinged cushions & flip-down armrests
>	�Helm bench seat w/convertible backrest & sliding base
>	�Aft facing transom lounger
>	�76 litre capacity pressure water system
>	�Enclosed head compartment with Electrical toilet
>	�Beverage holders, stainless steel
>	�Stereo, 12V AM/FM, Wireless Bluetooth™, weatherproof speakers (4) & 

digital cockpit remote control
>	�CE Fire Suppression System - automatic w/manual pull
> Bimini Top w/Boot, Stainless Steel Bal & Socket Hardware 
> Canvas, Cockpit and Tonneau Cover 
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Shower on Transom 
> Cockpit Table, Fiberglass

OPTIONS & ACCESSORIES
OPTIONAL ENGINES  
>	�Mercruiser ECT 6.2L MPI Bravo III w/DTS Sterndrive (350 php - 261 kW)
>	�Non ECT Engines available outside EU

8,3 M | 2,59 M 283 L 2.631 KG
S E A  R A Y 
S U N  S P O R T ®  2 3 0

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Moteur mixte MerCruiser® 4.5 MPI Alpha I (250 ch - 188 kW)
>	�Interrupteur de batterie in Coupe Batterie Casier in Rangement
>	Porte-verres en acier inoxydable
>	Profondimètre
>	Siège pilote pivotant
>	Rangements supplémentaires sous les sièges
>	Poignées en acier inoxydable
>	3 compartiments verrouillables
>	Feux de navigation
>	Prise auxiliaire 12 V
>	Siège bâbord avec dossier réversible
>	Rail de frottement en PVC noir avec insert en acier inoxydable
>	Radio AM/FM stéréo avec télécommande et haut-parleurs étanches (2)
>	Casier à ski dans le sol
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Plate-forme de bain avec échelle de bain à quatre marches

OPTIONS & ACCESSOIRES
OPTIONAL ENGINES    
> Moteur mixte MerCruiser® ECT 4.5 MPI Bravo® III (250 ch – 188 kW)
> Moteur mixte MerCruiser ECT 4.5L MPI Bravo® III avec DTS* (250 ch - 188 kW)
> Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (300 ch - 224 kW)
> Moteurs non-ECT disponibles en dehors de l’UE

8 P / 870 KG

KIT DU CAPITAINE
> Bimini inox
> Taud de cockpit et avant
> Moquettes amovibles
> Table de cockpit en polyester
> Sondeur
> Coussin bain de soleil arrière
> Essui glace tribord

KIT ÉLÉVATION
> Tour de wake-board avec bimini 
> inox
> Supports de wake
> Mirroir de ski
> Visière de tableau de bord

7.01 M | 2,59 M 189 L 1.237 KG

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	��� Moteur mixte MerCruiser® ECT 6.2L MPI Bravo® III avec DTS (300 ch - 224 kW)
>	�� Taud Bimini avec coffre
>	�� Taud de cockpit avec couvre-tonneau
>	��� Plate-forme de bain avec échelle de bain à quatre marches en acier inoxydable 

encastrée et boulonnée
>	�� Œillet de ski nautique encastré à l’arrière
>	��� Vinyles assortis avec motif à losanges et accent vinyle : sable (perle) avec 

revêtement tapis enfichable Sterling
>	�� Table de cockpit en fibre de verre
>	�� Banquette avant avec coussins relevables et accoudoirs rabattables
>	��� Banquette du poste de pilotage avec dossier convertible et base coulissante
>	�� Transat arrière orienté vers la plate-forme
>	�� Réservoir d’eau pressurisée de 76 litres
>	�� Compartiment toilettes fermé avec WC électrique
>	�� Porte-verres en acier inoxydable
>	��� Radio AM/FM stéréo 12 V, Bluetooth™ sans fil, 4 haut-parleurs résistants aux 

intempéries et télécommande numérique dans le cockpit
>	�� Système de lutte incendie CE automatisé avec déclenchement manuel 
> Bimini inox
> Taud de cockpit et avant
> Moquettes amovibles
> Douchette sur tableau arrière
> Table de cockpit en polyester
> Feu d’approche

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
>	�� Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (350 ch - 261 kW)
>	�� Moteurs non-ECT disponibles en dehors de l’UE

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	�� Motor de popa MerCruiser® ECT 6.2 MPI Bravo® III con DTS (300 hp - 224 kW)
>	�� Toldo Bimini con funda
>	�� Toldos de la bañera y de la capota
>	�� Plataforma de baño con escalera empotrada de cuatro peldaños de acero 

inoxidable
>	�� Remolque para esquí acuático en espejo de popa - montado a ras de suelo
>	�� Vinilos en colores a juego con patrón de diamantes y detalles de vinilo: arena 

(perla) con protector de moqueta a corchetes
>	�� Mesa de la bañera, de fibra de vidrio
>	�� Asientos de proa con cojines extraíbles y reposabrazos abatibles
>	�� Asiento de timón con respaldo convertible y base deslizante
>	�� Tumbona solárium cara a popa.
>	�� Sistema de agua a presión de 76 litros de capacidad
>	�� Cuarto de baño con inodoro eléctrico
>	�� Portabebidas, acero inoxidable
>	�� Equipo estéreo, 12V AM/FM, Bluetooth™ inalámbrico, altavoces resistentes a la 

intemperie (4) y mando a distancia digital desde la bañera
>	�� Sistema EC de extinción de incendios - automático con bomba manual 
> Bimini top con barras acero Inox
> Fundas para Bañera y Proa
> Moqueta en bañera
> Ducha popa bañera
> Mesa en bañera
> Luces de atraque

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
>	�� Motor de popa MerCruiser ECT 6,2 l MPI Bravo III con DTS (350 hp - 261 kW)
>	�� Motores sin ECT disponibles fuera de la UE

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	�� Mercruiser® ECT 6,2 l MPI Bravo® III mit DTS Heckantrieb (300 PS - 224 kW)
>	�� Bimini-Verdeck mit Hülle
>	�� Segeltuch, Cockpit- und Fahrgastraumabdeckung
>	�� Badeplattform mit versenkter Badeleiter (4 Stufen) aus Edelstahl ange-

schraubt
>	�� Wasserski-Schleppöse - bündig eingelassen
>	�� Abgestimmte Vinylfarben mit Diamantmuster und farblichen Akzenten: 

Sand (Perlmutt) mit einknöpfbarem Sterling-Fußbodenbelag
>	�� Cockpit-Tisch, Fiberglas
>	�� Bug-Liegesitze mit drehbaren Kissen und herunterklappbaren Armlehnen
>	�� Steuerstandbank mit verstellbarer Rückenlehne und verschiebbarer Basis
>	�� Nach achtern gerichtete Heckliege
>	�� Druckwassersystem mit Kapazität von 76 Litern
>	�� Geschlossene Nasszelle mit elektrischer Toilette
>	�� Getränkehalter aus Edelstahl
>	�� Stereo, 12V AM/FM, Wireless Bluetooth™, wetterfeste Lautsprecher (4) und 

digitale Cockpit-Fernbedienung
>	�� CE-Feuerlöschsystem - automatisch mit manuellem Zug OPTIONEN UND 

ZUBEHÖR
> Bimini-Top mit Hülle
> Sportpersenning und 
> Bugabdeckung
> Cockpitteppich einknöpfbar
> Heckdusche
> Cockpittisch aus GfK
> Docking Lights (Leuchten im Bug)

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
>	�� MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS Heckantrieb (350 PS - 261 kW)
>	�� Nicht-ETC-Motoren außerhalb der EU verfügbarKIT ÉLÉVATION

> Tour de wake board Blanche 
avec système d’abaissement pour 
stockage
> Supports de wake
> Mirroir de ski
> Compresseur à air pour 
accessoires gonflables

KIT SÉLECTION
> Coussin avant pour bain de soleil
> Coussin table de cockpit

PAQUETE DE ELEVACIÓN
> Torre Blanca para deportes 
abatible con almacenamineto 
de  Bimini
> Soportes giratorios para tablas 
de esquí
> Espejo esqui
> Compresor de Aire para

PAQUETE SELECTO
> Torre para deportes acuáticos 
con Bimini
> Soporte para tablas de Wake
> Espejo para esqui
> Dash visor

ELEVATION-AUSFÜHRUNG
> Weißer Wassersporttower mit 
> Ausziehbarem Bimini-Top
> Wakebordracks
> Wasserskispiegel
> Luftkompressor

SELECT-AUSFÜHRUNG
> Bugfüllpolster
> Cockpittisch im Bug

ELEVATION PACKAGE
> Watersport Tower, White with Tilting 
> Bimini Storage System
> Swivel Wakeboard Racks
> Ski Mirror
> Air Compressor for Water Toys

SELECT PACKAGE
> Bow Filler Cushion 
> Bow Cockpit Table

INDIVIDUAL OPTIONS
> Bottom Paint
> Docking Lights 
> Submersible Swimplatform, 
Manual Operated
> Trim Tabs, Hydraulic
> Under Water Lights, Through Hull 
> Windlass - Electric with Chain & 
SST Anchor
> Canvas Pack: Incl: Aft Curtain, Front & 
Side Curtains
> Mooring Cover, Black
> Hot Water - Heat Exchanger
> Infinity, Woven Cockpit Flooring 
> Led Package in Cockpit - Blue or White
> Refrigerator (12 volt) in Cockpit
> SeaDek covering on Swim plfatorm 
(Gray or Mocha) 

> Teak Cockpit Upgrade to replace 
Carpet
> Teak On Swim Platform
> Wet Bar w/ Integral Sink & Faucet
> Digital Dash W/ Merc Vesselview 
Link (9”)
> Premier Stereo w/ extra speakers and 
SW & Transom remote
> Transom Remote Trim Switch
> Battery Charger

OPTIONS INDIVIDUELLES
> Antifouling usine
> Plateforme de bain submersible 
manuellement
> Commandes trim sur tableau arrière
> Lumières sous plateforme de bain
> Guindeau éléctrique avec chaîne et 
ancre en inox
> Package Fermeture de bimini (Avant, 
cotés et arrière)
> Taud de mouillage, noir et 1 pièce.
> Eau chaude
> Package Led dans le Cockpit- bleu 
ou blanc
> Moquette fine infinity

> Réfrigérateur (12 volts) dans le 
Cockpit
> Sea deck sur plateforme de bain 
(Grise ou mocha)
> Cockpit recouvert de teck ( Remplace 
les moquettes)
> Teck sur plateforme de bain
> Lavabo/Bar dans cockipt
> Ecran digital sans chartplotter
> Stereo Premium avec des enceintes 
> Supplémentaires et caissons de 
basses
> Commande Trim sur tableau arrière
> Chargeur de batterie

OPCIONES INDIVIDUALES
> Pintura de fondos
> Plataforma de Baño Sumergible, 
> Manual
> Flaps hidráulicos
> Luces del casco
> Molinete con ancla de Acero
Calefactor de agua

> Conjunto Led en Bañera:
> Nevera en bañera de 12v
> SeaDeck para la plataforma de baño 
(Gris o Mocha)
> Teca en bañera

> Teca en plataforma de baño
> Mueble bar en bañera
> Estereo Premium
> Mando en popa para trim
> Cargador de bateria=

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Manuelle Unterwasserplattform
> Hydraulische Trimklappen
> Unterwasserbeleuchtung durch 
den Rumpf
> Elektrische Ankerwinde mit Kette 
und edelstahlanler
> Heißwassersystem
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Blaues oder weißes LED-Lichtpaket
>Cockpitkühlschrank (12 V)
> Seadek-Boden auf der Badeplattform
> Teakboden im Cockpit

> Teak auf der Badeplattform
> Wetbar mit Spüle
> Digitales Armaturenbrett mit 
> Kartenplotter
> Premium Stereosystem mit 
> Subwoofer
>Trim- / Tiltschalter am Heck
> Onboard Batterieladegerät

FEATURES & STANDARD EQUIPMENT
>	Mercruiser® ECT 4.5 MPI Alpha® I Sterndrive (250 hp - 188 kW)
>	Battery On/Off Switch
>	Cup Holder, Stainless-Steel
>	Depth Finder
>	Driver seat turnable
>	Extra Storage under seats
>	Grab Handles, Stainless-Steel
>	3 Lockable Storage Areas
>	Navigation Lights
>	Outlet, 12V Accessory
>	Reversible backrest port seat 
>	Rub Rail, Black PVC w/Stainless Steel Insert
>	Stereo, 12V AM/FM with Remote Control & Weatherproof Speakers (2)
>	Ski Locker in floor
> CE Fire Suppression System - automatic
>	Swim Platform, Four-Step Swim Ladder

OPTIONS & ACCESSORIES
OPTIONAL ENGINES       
>	Mercruiser ECT 4.5L MPI Bravo® III MCM  (250 PHP)          
> Mercruiser ECT 4.5L MPI Bravo® III DTS (250 PHP)              
>	Mercruiser ECT 6.2L MPI DTS Bravo III (300 PHP)      
>	Non ETC Engines available out side EU

CAPTAIN’S PACKAGE
> Bimini Top w/Boot, Stainless 
Steel Bal & Socket Hardware 
> Canvas, Cockpit and Tonneau Cover 
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Table, Fiberglass
Depth Finder
> Sunpad Walk-Thru Cushion 
> Windshield Wiper Starboard

ELEVATION PACKAGE
> Water Sports Tower Black w/ 
Bimini Top
> Tower Racks 
> Ski Mirror
> Dash Visor

INDIVIDUAL OPTIONS
> Bottom Paint
> Submersible Swimplatform, Manual
Operated
> Canvas Pack Incl: Aft Curtain, Front & 
Side Curtains
> Mooring Cover, Black
> Air Compressor
> Cockpit Table, Teak 
> Cockpit Coolbox
> Infinity, Woven Cockpit Flooring 
> Sunpad on front deck with Deck 
Runners
> Led Package in Cockpit - Blue or 
White
> Refrigerator (12 volt) in Cockpit
> SB Bucket Seat with PS  Reversible 

> Loungeseat 
> SeaDek covering on Swim plfatorm 
( Gray or Mocha) 
> Windlass - Electric with Chain & 
SST Anchor
> Toilet - Portable 
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview 
> Link 9”
> Premier Stereo w/ extra speakers /  
SW & Transom remote 
> Transom Remote, Stereo
> Transom Trailer Trim Switch
> On Board Battery Charger

OPTIONS INDIVIDUELLES
> Peinture coque couleur dessous
> Plateforme de bain submersible 
manuellement
> Package Fermeture de bimini ( Avant, 
cotés et arrière)
> Taud de mouillage, noir et 1 pièce.
> Compresseur d’air
> Table de cockpit teck
> Glacière dans cockpit
> Moquette fine infinity
> Bain de soleil avant avec main 
courantes
> Package Led dans le Cockpit- bleu 
ou blanc
> Réfrigérateur (12 volts) dans le 
Cockpit
Assise passager babord reversible

> Sea deck sur plateforme de bain 
(Grise ou mocha)
> Guindeau éléctrique avec chaîne et 
ancre inox
> WC Chimique portable
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview 
Link 9”
> Stereo Premium avec des enceintes 
Supplémentaires et caissons de basses
> Commande pour stereo sur Tableau 
arrière
> Commande Trim sur tableau arrière
> Chargeur de batterie embarqué

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motor de popa* MerCruiser 4,5 l MPI Alpha I (250 hp - 188 kW)
>	Interruptor de batería On/Off
>	Portabebidas, acero inoxidable
>	Indicador de profundidad
>	Asiento piloto giratorio
>	Espacio de estiba adicional debajo de los asientos
>	Asideros, acero inoxidable
>	Tres espacios de estiba con cerradura
>	Luces de navegación
>	Toma de corriente 12V, Accesorio
>	Asiento de babor con respaldo reversible
>	Listón negro, PVC negro con implante de acero inoxidable
>	�Estéreo, 12V AM/FM con mando a distancia y altavoces resistentes  

a la intemperie (2)
>	Guarda-esquís en el piso
> Sistema EC de extinción de incendios - automático con bomba manual
>	Plataforma de baño, escalera con cuatro peldaños

OPCIONES Y ACCESORIOS
OPTIONAL ENGINES    
>Motor de popa MerCruiser® ECT 4.5 MPI Bravo® III (250 hp - 188 kW)
> Motor de popa MerCruiser ECT 4,5 l MPI Bravo® III con DTS* (250 hp - 188 kW)
> Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (300 hp - 224 kW)
>	�Motores ECT opcionales disponibles

PAQUETE CAPITÁN
> Bimini Top
> Funda de bañera y proa
> Moqueta en bañera
> Mesa en bañera
> Profundimetro
> Colchoneta paso solarium
> Limpiaparabrisas Estribor

PAQUETE DE ELEVACIÓN
> Torre para deportes acuáticos 
con Bimini
> Soporte para tablas de Wake
> Espejo para esqui
> Dash visor

OPCIONES INDIVIDUALES
> Pintura de fondos
> Plataforma de Baño Sumergible, 
Manual
> Cierre c/ toldos a partir de toldo de sol
> Lona de cierre completa
> Compresor de aire 
> Mesa en bañera de Teka
> Coolbox 
> Colchoneta de proa 
> Conjunto luces Led : Azul o blanco
> Nevera en bañera (12v)
> Asiento babor reversible
> SeaDek- Plataforma de Baño 
( Gris o Mocha)

> Molinete con ancla en acero inox
> Wc portatil
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview 
Link 9”
> Mejora de estéreo Premier
> Control Remoto Popa para estereo
> Trim en popa
> Cargador de bateria

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	MerCruiser® 4,5 l MPI Alpha I Heckantrieb (250 PS - 188 kW)
>	Ein-/Aus-Schalter für Batterie
>	Getränkehalter aus Edelstahl
>	Tiefenmesser
>	Drehbarer Steuersitz
>	Zusätzlicher Stauraum unter den Sitzen
>	Handgriffe aus Edelstahl
>	3 geschlossene Stauräume
>	Navigationsleuchten
>	Steckdose, 12V, Zubehör
>	Herunterklappbare Rückenlehne für Backbord-Sitz
>	PVC-Scheuerleiste, schwarz, mit Edelstahleinsatz
>	Stereo, 12V AM/FM mit Fernbedienung & wasserdichten Lautsprechern (2)
>	Staufach für Wasserski im Fußboden
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	Badeplattform, Badeleiter mit 4 Stufen

OPTIONEN UND ZUBEHÖR
OPTIONAL ENGINES    
> MerCruiser® ECT 4,5 l MPI Bravo® III Heckantrieb (250 PS - 188 kW)
> MerCruiser® ECT 4,5 l MPI Bravo® III mit DTS* Heckantrieb (250 PS - 188 kW)
> MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (300 PS - 224 kW)
>	�Nicht-ETC-Motoren außerhalb der EU verfügbar

CAPTAIN’S-AUSFÜHRUNG
> Bimini-Top mit Hülle
> Sportpersenning und Bugab-
deckung
> Cockpitteppich einknöpfbar
> Cockpittisch aus GfK
> Echolot
> Füllpolster für die Sonnenliege
> Scheibenwischer stb.

ELEVATION PACKAGE
> Schwarzer Wakebordtower mit 
> Bimini-Top
> Wakebordracks
> Wasserskispiegel
> Blende für Armaturenbrett

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Manuelle Unterwasserplattform
> Verdeckpaket für Bimini-Top
> Vollpersenning
> Luftkompressor
> Cockpitteisch aus Teak
> Kühlschrank im Cockpit
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Sonnenliege auf dem Vorderdeck mit 
> Edelstahlreling
> Blaues oder weißes LED-Lichtpaket
> Kühlschrank im Cockpit (12V)
> Umklappbarer Beifahrersitz / 
Sitzbank
> Seadek Belag auf der Badeplattform

> Elektrische Ankerwinde mit Kette 
und Edelstahlanker
> Chemie-WC (Porta Potti)
> GPS-Kartenplotter / Fischfinder - 
Raymarine
> Chartplotter / Sonar 5”
> Digital Dash w/ Merc Vesselview 
Link 9”
>. Premium Stereosystem mit 
Subwoofer
> Fernbedienung für die Stereoanlage 
am Heck
> Trim- / Tiltschalter am Heck
Onboard Batterieladegerät
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CAPTAIN’S PACKAGE
> Canvas, Cockpit and Tonneau Cover 
> Cockpit Shower on Transom 
> Docking Lights 
> Windshield Wiper Starboard

ELEVATION PACKAGE
> Water Sports Tower Black w/ 
Bimini Top
> Swivel Wakeboard Racks
> Ski Mirror
> Air Compressor for Water Toys

SELECT PACKAGE
> Cockpit table, Teak with Filler 
cushions (replaces fiberglass table)

INDIVIDUAL OPTIONS
> Bottom Paint
> Bow Thruster
> Submersible Swimplatform, 
Manual Operated
> Trim Tabs, Hydraulic
> Under Water Lights, Through Hull

> Bow Rail, high with open front 
(Replace std deck rails)
> Foredeck Sunpad (Needs Bow Rail)
> Ladder Bow Hatch (not with 
Anchor Winch)
> Windlass - Electric with Chain & 
SST Anchor
> Canvas Pack: Incl: Aft Curtain, Front 
& Side Curtains
> Mooring Cover, Black
> Carpet Liner, Snap-In (Cockpit)
> Cockpit Heater from engine
> Infinity, Woven Cockpit Flooring 
> Led Package in Cockpit - Blue 
or White
> Refrigerator (12 volt) in Cockpit
> SeaDek covering on Swim Platform 
(Gray or Mocha) 
> Teak Cockpit Upgrade to replace 
Carpet
> Teak On Swim Platform 
> Premier Stereo w/ extra speakers 
and SW & Transom remote
> Transom Remote Trim Switch
> Battery Charger

FEATURES & STANDARD EQUIPMENT
> Mercruiser ECT 4.5L MPI Bravo® III w/DTS* Sterndrive (250 php - 188 kW)
>	�Bimini Top w/boot 
>	�Large berth in cabin
>	�Integrated swim platform w/recessed stainless-steel four step swim 

ladder
>	�Ski tow eye-transom
>	�Cockpit table, fiberglass
>	�Transom sun pad
>	�Beverage holders, stainless steel
>	��Color Coordinated Vinyls w/Diamond Pattern and Accent Vinyls:  

Sand (Pearl) with Sterling snap-in carpet liner
>	�Stereo, 12V AM/FM, Wireless Bluetooth™, Dual Zone Volume Control, 

Amplifier &  Weatherproof Speakers 
>	�Battery On/Off Switch - remote battery switch at helm
>	�CE Fire Suppression System - automatic w/manual pull
>	�Electrical Toilet and Macerator

OPTIONS & ACCESSORIES
OPTIONAL ENGINES      
>	�Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (300 php - 224 kW)
>	�Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (350 php - 261 kW)
> Mercury Diesel TDI 3.0L 265 DTS Bravo llx Sterndrive (265 hp - 198 KW)
>	�Non ECT Engines Available outside EU

S E A  R A Y 
S U N  S P O R T ®  2 5 0 7,9 M | 2,59 M 283 L 2.631 KG

S E A  R A Y 
S U N D A N C E R ®  2 6 5

FEATURES & STANDARD EQUIPMENT
>	Mercruiser ECT 6.2L MPI DTS Bravo III (300 - 244 KW)    
>	�Anchor Storage Hatch on bow
>	Bathroom with vanity, Shower, Electrical toilet and Macerator
>	�Bimini Top w/Boot & Vertical Storage
>	�Canvas Package: Aft Curtain, Front Curtains, Side Curtains & Canvas 

Storage Bag
>	Carpet Liner, Snap-In
>	�Cabin Galley w/Sink, Single Burner Cooker & Refrigerator 12V
>	�Cockpit Cover w/Canvas Storage Bag
> 	Dual Battery Switch & Shore Power w/ Battery Charger
>	Docking Lights 
>	Fold-down Transom Seat with Storage
>	�Luxury Wallnut wood finish inside the cabin with Shoji doors and solid 

wood frames
> 	Outlet, 12V Accessory, Outlet, 220V/50 Cycle
> 	�Stereo, MP3 / USB Port, 4 Weatherproof Speakers 
>	�Swim Platform, Stainless Steel Swim Ladder
>	Table, Cockpit - Teak
>	Trim tabs, Electric
> CE Fire Suppression System - automatic w/manual pull
>	Windshield Wiper - Starboard 

OPTIONS & ACCESSORIES

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	�Moteur mixte MerCruiser 6.2L MPI Bravo III avec DTS (300 ch - 224 kW)
>	Panneau du coffre à ancre à la proue
>	Salle de bains avec lavabo, douche, WC - chasse d’eau manuelle
>	Taud Bimini avec coffre et rangements verticaux
>	�Kit taud : rideau arrière, rideaux avant, rideaux latéraux et sac  

de rangement pour tauds
>	Revêtement tapis enfichable
>	Cuisine dans une cabine avec évier, cuisinière 1 feu et réfrigérateur 12 V
>	Bâche de cockpit avec sac de rangement pour taud
>	�Commutateur de sélection de batterie et prise d’alimentation  

avec chargeur de batterie
>	Feux d’amarrage
>	Banquette arrière repliable avec compartiment
>	�Finition noyer de luxe avec portes Shoji et cadres en bois solides  

à l’intérieur de la cabine
>	Prise auxiliaire 12 V, prise, 220 V/50 Hz
>	Lecteur de CD Sony® stéréo avec port MP3/USB, 4 haut-parleurs étanches
>	Plate-forme de bain avec échelle en acier inoxydable
>	Table de cockpit en teck
>	Régulateurs d’assiette électriques
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Essuie-glace tribord

OPTIONS & ACCESSOIRES

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	�Motor de popa MerCruiser 6,2L MPI Bravo III con DTS (300 hp - 224 kW)
>	Pozo de ancla en proa
>	Baño con lavabo, ducha, inodoro - cadena manual
>	Toldo de bimini con raya y almacenamiento vertical
>	�Conjunto de lonas: cortina de popa, cortinas frontales, cortinas laterales y 

bolsa para guardar lonas
>	Protector de moqueta “a presión” con corchetes
>	Cocina para la cabina con fregadero, un fogón y frigorífico de 12V
>	Cubierta para la bañera y bolsa para guardar la lona
>	�Interruptor de baterías dual y toma de alimentación del muelle  

con cargador para baterías
>	Luces de atraque
>	Asiento plegable de popa con espacio de estiba
>	�Sofisticado acabado en nogal dentro de la cabina con puertas shoji  

y marcos de madera maciza
>	Toma de corriente, accesorio 12V, Toma de corriente, ciclo 220V/50
>	�Equipo estereofónico Sony® con reproductor de CD con puerto MP3/USB, 

4 altavoces a prueba de intemperie
>	Plataforma de baño, con escalera de acero inoxidable
>	Mesa, bañera - Teca
>	Aletas de compensación hidráulica
> Sistema EC de extinción de incendios - automático con bomba manual
>	Limpiaparabrisas - Estribor

OPCIONES Y ACCESORIOS

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	�MerCruiser 6,2 l MPI Bravo III mit DTS Heckantrieb (300 PS - 224 kW)
>	Ankerfach mit Luke auf im Bug
>	Badezimmer mit Waschtisch, Dusche, WC - manuelle Spülung
>	Bimini-Verdeck mit Hülle und vertikalem Stauraum
>	�Segeltuchpaket: hinterer Vorhang, Vorhänge vorne und seitlich 

Aufbewahrungstasche
>	Einknöpfbarer Teppichboden
>	�Kombüse in der Kabine mit Spüle, Herd mit einem Brenner und 

Kühlschrank 12 V
>	Cockpitabdeckung mit Aufbewahrungstasche aus Segeltuch
>	Batterieschalter, dual & Hafenstrom mit Batterieladegerät
>	Anlegelichter
>	Herunterklappbarer Hecksitzplatz mit Stauraum
>	�Innenausstattung der Kabine in exklusivem Nussbaum,  

mit Shoji-Türen und soliden Holzrahmen
>	Steckdose 12V Zubehör, Steckdosen 220V/50Hz
>	�Sony® Stereoanlage mit CD-Spieler, MP3-/USB-Anschluss und 

4 wasserdichten Lautsprechern
>	Badeplattform, Badeleiter aus Edelstahl
>	Cockpit-Tisch, Teakholz
>	Elektrische Trimmklappen
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	Scheibenwischer, steuerbord

OPTIONEN UND ZUBEHÖR

OPTIONS INDIVIDUELLES
> Antifouling usine
> Propulseur d’étrave
> Feux d’approche
> Flaps Hydraulic
> Bain de soleil avant avec mains 
courantes
> Guindeau éléctrique avec chaîne 
et ancre inox
> Arceau polyester avec Bimini
> Package taud Camper (pour 
bateau avec arceau ou open)
> Réfrigérateur (12 volts) dans le 
> Cockpit

> Cockpit recouvert de teck 
 Remplace les moquettes)
> Extension de plateforme de bain 
recouverte de teck
> Moquette fine infinity
> Micro-ondes 220v/50
> Micro-ondes 120v/60
> Chart Plotter avec GPS
> Stereo Premium avec des 
enceintes supplémentaires et 
caissons de basses
> Chauffage de cockpit- 
alimentation moteur 
> Chauffage cabine et cockpit - 
diesel

OPCIONES INDIVIDUALES
> Pintura de fondos
> De proa
> Luces de atraque
> Flaps
> Colchoneta de proa
> Molinete con Cadena y con ancla 
acero inox.
> Infinity, Woven Cockpit Flooring 
> Conjunto de Toldos  Incl: Toldos de 
> Toldos Camper (Con arco o open)
> Nevera en bañera - 12v
> Mejoras de teca
> Teca en plataforma de baño 
> Microondas 220v/50
> Microondas 120v/60 Plotter / 
Sonda con GPS

> Mejora Estéreo Premier con extra,  
SW & control en popa
> Cabina y bañera Webasto para 
diesel

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Bugschraube
> Docking Lights (Leuchten im Bug)
> Hydraulische Trimklappen
> Sonnenliege auf dem Vorderdeck
> Elektrische Ankerwinde mit Kette 
und Edelstahlanker
> Radarbügel aus GfK
> Camperverdeckpaket
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Kühlschrank im Cockpit (12 V)
> Teakboden im Cockpit
> Teakboden auf der Badeplattform
> Mikrowelle 220 V
> 7” GPS-Kartenplotter 
> Fischfinder
> Premium Stereosystem mit 
Subwoofer

> Cockpitheizung über den Motor
> Heizung Webasto (Diesel) für 
Kabine und Cockpit

4 P8 P / 816 KG8,07 M | 2,59 M 261 L 2.875 KG

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	� Moteur mixte MerCruiser ECT 4.5L MPI Bravo® III avec DTS* (250 ch - 188 kW)
>	� Taud Bimini avec coffre
>	� Grande couchette dans la cabine avec WC portable
>	�� Plate-forme de bain intégrée avec échelle de bain à quatre marches en acier 

inoxydable encastrée
>	� Œillet de ski nautique arrière
>	� Table de cockpit en fibre de verre
>	� Bain de soleil arrière
>	� Porte-verres en acier inoxydable
>	��� Vinyles assortis avec motif à losanges et accent vinyle : 

sable (perle) avec revêtement tapis enfichable Sterling
>	�� Radio AM/FM stéréo 12 V, Bluetooth™ sans fil, commande du volume bizone, 

amplificateur et haut-parleurs résistants aux intempéries 
>	�� Interrupteur de batterie avec commande à distance dans le poste de pilotage
>	� Système de lutte incendie CE automatisé avec déclenchement manuel
>	� Broyeur et WC électrique

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
>	� Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (300 ch - 224 kW)
>	� Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (350 ch - 261 kW)
> Moteur diesel TDI® Mercury® 3.0L 265 DTS Bravo® IIIx (265 ch - 198 kW)
>	� Moteurs non-ECT disponibles en dehors de l’UE

KIT DU CAPITAINE
> Taud de cockpit et avant
> Douchette sur tableau arrière
> Feu d’approche
> Essui glace tribord

KIT ÉLÉVATION
> Tour de wake-board Noir avec 
Bimini inox
> Supports de wake
> Mirroir de ski
> Compresseur à air pour accessoires 
gonflables

KIT SÉLECTION
> Table de cockpit en teck (remplace 
celle en polyester)

OPTIONS INDIVIDUELLES
> Antifouling usine
> Propulseur d’étrave
> Plateforme de bain submersible 
manuellement
> Commandes trim sur tableau 
arrière
> Lumières sous plateforme de bain
> Balcon avant ( remplace les mains 
courantes de pont avant)
> Bain de soleil avant avec mains > 

courantes (selectionner opt balcon 
avant obligatoire)
> Coffre échelle de bain avant (non 
dispo quand Guindeau)
> Guindeau éléctrique avec chaîne et 
ancre en inox
> Package Fermeture de bimini ( 
Avant, cotés et arrière)
> Taud de mouillage, noir et 1 pièce. 
> Moquettes amovibles (cockpit)
> Chauffage de cockpit de la calle 
moteur
> Moquette fine infinity
> Package Led dans le Cockpit- bleu 
ou blanc
> Réfrigérateur (12 volts) dans le 
Cockpit
> Sea deck sur plateforme de bain 
(Grise ou mocha)
> Cockpit recouvert de teck ( 
Remplace les moquettes)
> Teck sur plateforme de bain
> Stereo Premium avec des enceintes 
supplémentaires et caissons de 
basses
> Commande Trim sur tableau arrière
> Chargeur de batterie

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motor de popa MerCruiser ECT 4,5 l MPI Bravo® III con DTS* (250 hp - 188 kW)
>	� Toldo Bimini con funda
>	� Cabina con litera grande e inodoro portátil 
>	� Plataforma de baño integral con escalera empotrada de cuatro peldaños de 

acero inoxidable
>	� Remolque para esquí acuático - espejo de popa
>	� Mesa de la bañera, de fibra de vidrio
>	� Solárium en espejo de popa
>	� Portabebidas, acero inoxidable
>	� Vinilos en colores a juego con patrón de diamantes y detalles de vinilo:arena 

(perla) con protector de moqueta a corchetes
>	� Equipo estéreo, 12V AM/FM, Bluetooth™ inalámbrico, control del volumen dual, 

amplificador y altavoces resistentes a la intemperie 
>	� Interruptor encendido/apagado batería - interruptor remoto de la batería  

en el timón
>	� Sistema EC de extinción de incendios - automático con bomba manual
> Inodoro eléctrico y bomba trituradora

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
>	� Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (300 hp - 224 kW)
>	� Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (350 hp - 261 kW)
> Motor de popa Mercury® Diesel TDI® 3,0L 265 DTS Bravo® IIIx (265 hp- 198 kW)
>	� Motores sin ECT disponibles fuera de la UE

PAQUETE CAPITÁN
> Fundas para Bañera y Proa
> Ducha popa bañera
> Luces de atraque
> Limpiaparabrisas Estribor

PAQUETE DE ELEVACIÓN
> Torre de deportes Negra c/ toldos 
Bimini
> Soportes giratorios para tablas 
de esquí
> Espejo esqui
> Compresor de Aire para

OPCIONES INDIVIDUALES
> Mesa bañera de teca (substituye la 
mesa de fibra)
> Pintura de fondos
> Helice de proa
> Plataforma de Baño Sumergible, 
Manual
> Flaps hidráulicos
> Luces casco 
> Rail alto para la proa (Sustituye el std)
> Colchoneta de proa
> Escalera de baño en proa
> Molinete con ancla de Acero
> Conjunto de Toldos  Incl: Toldos de 
Popa, Frontales  y Laterales

> Lona de fondeo
> Moqueta en bañera
> En bañera de motorr
> Infinity, Woven Cockpit Flooring 
> Conjunto Led en Bañera:
> Nevera en bañera de 12v
> SeaDeck para la plataforma de baño 
(Gris o Mocha)
> Teca en bañera
> Teca en plataforma de baño 
> Estereo Premium
> Mando en popa para trim
> Cargador de bateria

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
> MerCruiser® ECT 4,5 l MPI Bravo® III mit DTS* Heckantrieb (250 PS - 188 kW)
>	� Bimini-Verdeck mit Hülle
>	� Große Koje in Kabine mit tragbarer Toilette
>	� Integrierte Badeplattform mit versenkter Badeleiter (4 Stufen) aus Edelstahl
>	� Wasserski-Schleppöse, Heck
>	� Cockpit-Tisch, Fiberglas
>	� Heck-Sonnenliege
>	� Getränkehalter aus Edelstahl
>	� Abgestimmte Vinylfarben mit Diamantmuster und farblichen Akzenten:Sand 

(Perlmutt) mit einknöpfbarem Sterling-Fußbodenbelag
>	� Stereo, 12V AM/FM, Wireless Bluetooth™, Dualzonen-Lautstärkeregler, 

Verstärker und
>	� Wetterfeste Lautsprecher 
>	� Batterie Ein/Aus-Schalter - abgesetzter Batterieschalter am Steuerstand
>	� CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	� Elektrischer Toilette und Macerator

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
>	� MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (300 PS - 224 kW)
>	� MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (350 PS - 261 kW)
> Mercury® Diesel TDI® 3,0 l 265 DTS Bravo® IIIx Heckantrieb (265 PS - 198 kW)
>	� Nicht-ETC-Motoren außerhalb der EU verfügbar

CAPTAIN'S-AUSFÜHRUNG
> Sportpersenning und Bugab-
deckung
> Heckdusche
> Docking Lights (Leuchten im Bug)
 > Scheibenwischer stb.

ELEVATION-AUSFÜHRUNG
> Schwarzer Wakebordtower mit 
Bimini-Top
> Wakebordracks
> Wasserskispiegel
> Luftkompressor

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Bugschraube
> Manuelle Unterwasserplattform
hydraulische Trimklappen
> Unterwasserbeleuchtung durch 
den Rumpf
> Hohe Bugreling
> Bugsonnenpolster (nur bei hoher 
Bugreling)
> Bugbadeleiter (nicht bestelbar bei 
elektrischer Ankerwinde)
> Elektrische Ankerwinde mit Kette 
und edelstahlanler
> Verdeckpaket für Bimini-Top

> Vollpersenning
> Cockpitteppich einknöpfbar
> Cockpitheizung über den Motor
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Blaues oder weißes LED-Lichtpaket
> Cockpitkühlschrank (12 V)
> Seadek-Boden auf der 
Badeplattform
> Teakboden im Cockpit
> Teak auf der Badeplattform
> Premium Stereosystem mit 
Subwoofer
> Trim- / Tiltschalter am Heck
> Onboard Batterieladegerät

INDIVIDUAL OPTIONS
> Bottom Paint
> Bow Thruster
> Docking Lights
> Trim Tabs, Hydraulic
>  Fordeck Sun Pad 
> Windlass - Electric with Chain & 
SST Anchor
> Arch with Adjusted Bimini Top
> Camper Canvas Package ( for boat 
with arch or open )
> Infinity, Woven Cockpit Flooring 
> Refrigerator (12 volt) in Cockpit
> Teak Cockpit Upgrade 
> Teak On Swim Platform
> Microwave - 220v/50
> Microwave - 120v/60
> Chart Plotter / Fishfiner  w/ GPS 

> Premier Stereo Upgrade with extra 
speakers,  SW & Transom remote
> Cockpit Heater w/heat from engine 
> Webasto Cabin and Cockpit Heating 
- Diesel

OPTIONAL ENGINES       
> Mercruiser ECT 6.2L MPI Bravo III w/DTS* Sterndrive (350 php - 261 kW)
> Mercury Diesel TDI 3.0L 265 DTS Bravo llx Sterndrive (265 hp - 198 KW)
>	Non ETC Engines available out side EU

MOTEURS OPTIONNELS
> Moteur mixte MerCruiser ECT 6.2L MPI Bravo III avec DTS* (350 ch - 261 kW)
> Moteur diesel TDI® Mercury® 3.0L 265 DTS Bravo® IIIx (265 ch - 198 kW)
>	�Moteurs non-ECT disponibles en dehors de l’UE

MOTORES OPCIONALES
> Motor de popa MerCruiser ECT 6,2 l MPI Bravo® III con DTS* (350 hp - 261 kW)
> Motor de popa Mercury® Diesel TDI® 3,0L 265 DTS Bravo® IIIx (265 hp- 198 kW)
>	�Motores sin ECT disponibles fuera de la UE

OPTIONEN FÜR MOTOREN
> MerCruiser® ECT 6,2 l MPI Bravo® III mit DTS* Heckantrieb (350 PS - 261 kW)
> Mercury® Diesel TDI® 3,0 l 265 DTS Bravo® IIIx Heckantrieb (265 PS - 198 kW)
>	�Nicht-ETC-Motoren außerhalb der EU verfügbar
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FEATURES & STANDARD EQUIPMENT
> Twin MerCruiser® ECT 4.5 MPI DTS Bravo III Sterndrive (250 hp - 188 kW)
> Cockpit Galley with Refrigerator & Sink
> Compass
> Battery Switch & Shore Power w/ Battery Charger
> Mid-Cabin with large double bed
> Freshwater Washdown Spigot
> Separated Enclosed Shower Cabin with door
> Shower, Cockpit-Cabin Hot & Cold
> Standard fiberglass arch w/Bimini & enclosures
> Stereo,  12V FM with MP3 / USB Port,
> iPod® Connection, Weatherproof Speakers & Digital Cockpit Remote
> Swim Platform, Extended w/Concealed Stainless Steel Swim Ladder
> Trim Tabs, Electric
> Water Heater, 220V (22 liter) w/Exchanger
> Wood Salon Flooring
> CE Fire Suppression System - automatic w/manual pull
> Electrical Toilet with macerator

OPTIONS & ACCESSORIES
OPTIONAL ENGINES      
> Twin Mercruiser ECT 6.2 MPI Bravo III w/DTS Sterndrive (300 hp - 224 kW)
> Twin MerCruiser® Diesel TDI® 3.0L 265 HO Bravo® IIIx (265 hp - 198 kW)
>	�Non ECT engines available outside EU
Axius available on above engine options
 

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
> Moteurs jumelés MerCruiser® 4.5 MPI DTS Bravo III (T250 ch - 188 kW)
> Cuisine dans le cockpit avec réfrigérateur
> Compas
> Feux d’amarrage
> Commutateur de sélection de batterie et prise d’alimentation
avec chargeur de batterie
> Cabine avant avec grand lit
> Cabine centrale avec grand lit double
> Robinet de rinçage à l’eau douce
> Bonne capacité de déplacement sur le pont
> Finition noyer de luxe à l’intérieur de la cabine avec portes Shoji
et cadres en bois solides
> Cabine de douche avec porte
> Douche dans le cockpit-cabine avec eau chaude et froide
> Arche en fibre de verre avec bâche Bimini et protection de série
> Combiné radio, FM stéréo 12V, port MP3/USB, connexion iPod®,
> Plate-forme de bain avec échelle de bain en acier inoxydable dissimulée
> Régulateurs d’assiette électriques
> Essuie-glaces avec rinçage à l’eau douce
> Système de lutte incendie CE automatisé avec déclenchement manuel
> Plancher du salon en bois

OPTIONS INDIVIDUELLES
MOTEURS OPTIONNELS
> Moteurs jumelés MerCruiser 6.2L MPI Bravo III avec DTS (300 ch - 224 kW)
> Moteurs jumelés diesel TDI® MerCruiser® 3.0L 265 HO Bravo® IIIx (265 ch - 198 kW) 
> Moteurs non-ECT disponibles en dehors de l’UE

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
> Motores de popa dobles MerCruiser® 4,5 l MPI DTS Bravo III (250 hp - 188 kW)
> Cocina en la bañera con frigorífico
> Luces de atraque
> Cabina frontal con cama de grandes dimensiones
> Cabina central con cama de matrimonio
de grandes dimensiones
> Grifo de lavado con agua dulce
> Buen paso de acceso (walkaround) en cubierta
> Sofisticado acabado en nogal dentro de la cabina con puertas shoji
y marcos de madera maciza.
> Cabina de ducha independiente con puerta
> Ducha, bañera, agua fría y caliente
> Arco en fibra de vidrio estándar con Bimini y entoldados
> Equipo estereofónico  12V FM con puerto MP3/USB,
conector para iPod®, altavoces a prueba de intemperie y mando
a distancia digital desde la bañera
> Plataforma de baño extendida con escalera oculta de acero inoxidable
> Aletas de compensación hidráulica
> Mesa de teca con colchonetas de extensión para el solárium
> Calentador de agua, 220V (22 l) con intercambiador
> Limpiaparabrisas con agua dulce para lavado
> Sistema EC de extinción de incendios - automático con bomba manual
> Suelo de madera en el salón

OPCIONES INDIVIDUALES
MOTORES OPCIONALES

> Motores de popa dobles MerCruiser 6,2L MPI Bravo III con DTS (300 hp - 224 kW)
> MerCruiser® Diesel dobles TDI® 3,0L 265 HO Bravo® IIIx (265 hp - 198 kW) 
> Motores sin ECT disponibles fuera de la UE

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
> Twin MerCruiser® 4,5 l MPI DTS Bravo III Heckantriebe (250 PS - 188 kW)
> Kombüse im Cockpit mit Spüle, Herd
> Kompass
> Anlegelichter
> Batterieschalter, dual & Hafenstrom mit Batterieladegerät
> Vorderkabine mit großem Bett
> Mittelkabine mit großem Doppelbett
> Innenausstattung der Kabine in exklusivem Nussbaum,
mit Shoji-Türen und soliden Holzrahmen
> Abgeschlossene Duschkabine mit Tür
> Dusche, Cockpit - Kabine, heißes und kaltes Wasser
> Serienmäßiger GfK-Radarbügel mit Bimini-Verdeck & Abdeckungen
> Stereoanlage, 12V FM mit MP3-/USB-Eingang,
iPod®-Anschluss, 4 wasserdichten Lautsprechern und digitaler Cockpit-
Fernbedienung
> Badeplattform, mit eingelassener Badeleiter aus Edelstahl
> Elektrische Trimmklappen
> Tisch im Cockpit
> Warmwasserspeicher 220V (22 Liter) mit Wärmeaustauscher
> Scheibenwischer mit Frischwasserspülung
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
> Holzbodenbelag im Salon

KUNDENSPEZIFISCHE OPTIONEN
OPTIONEN FÜR MOTOREN
> Twin MerCruiser 6,2 l MPI Bravo III mit DTS Heckantrieb (300 PS - 224 kW)
> Twin MerCruiser® Diesel TDI® 3,0 l 265 HO Bravo® IIIx (265 PS - 198 kW) 
> Nicht-ETC-Motoren außerhalb der EU verfügbar

10 P / 1217 KG

INDIVIDUAL OPTIONS
> Bottom Paint
> Bow Thruster
> Docking Lights
> Automated Submersible Swim 
Platform
> Under Water Lights, Through Hull
> Spotlight - 5 Remote Controlled
> Windlass - Electric with Chain & 
> SST Anchor
> Hardtop, Fiberglass
> Opening Canvas Section - 
Fiberglass Hardtop
> Extended Sunshade
> Camper Canvas Package 
( for boat with arch or open )
> Camper Canvas Package With 
> Hardtop
> Canvas Cockpit Cover
> Foredeck Sunshade
> Bow Table with Dedicated Storage
> Cockpit Cooker (Alcohol and/
or Electric)
> Cockpit Table with Teak - conver-
ting to Sunpad
> Fender Clips
> Grill-Cockpit-Built In-220V/50
> Infinity, Woven Cockpit Flooring 
> Led Package in Cockpit - Blue 
or White
> Refrigerator (12 volt) in Cockpit

> SeaDek covering on 
Swim Platform ( Gray or Mocha) 
> Teak On Swim Platform
> Teak Flooring - Bow, Cockpit &  
Swim Platform
> Transom Sunpad Seating
> Portlight - Opening - 1 Galley &  
Salon Area
> Flat Screen w/ DVD - Salon - 220v/50
> T.V. - Flat Screen w/ DVD - 
Mid-Stateroom - 220v/50
> V-Berth Table Support,Adjustable
> Digital Dash w/ Merc Vesselview 
Link 9”
> 4G Radar
> Inverter - 12V to 220V/50 Cycle
> Premier Stereo - Combined Cabin 
& Cockpit 
> Air Conditioning / Heating - 
220v/50 (Cabin Only)
> Air Conditioning / Heating, Cabin 
and Cockpit - 220V/50
> Flagpole
> Generator - Gas - 220v/50HZ 
> Generator - Diesel - 220v/50HZ 
> Webasto Cabin 
> Heating - Diesel

OPTIONS INDIVIDUELLES
> Antifouling usine
> Propulseur d’étrave
> Feux d’approche
> Plateforme de bain submersible auto
> Lumière sous marine
> les lumières spots
> Guindeau éléctrique avec chaîne 
et ancre inox
> Hardtop polyester
> Taud de fermeture arrière pour 
> Hardtop Polyester
> Extension de bimini
> Table avant avec rangement dédié
> Kitchenette dans cockpit electri-
que (Electrique ou manuelle)
> Table de cockpit teck convertible 
bain de soleil
> Attache pare battage
> Grill dans le cockpit intégré 
220V/50
> Moquette fine infinity
> Package Led dans le Cockpit- 
bleu ou blanc
> Réfrigérateur (12 volts) dans le 
Cockpit
> Sea deck sur plateforme de bain 
(Grise ou mocha)
> Extension de plateforme de bain 
recouverte de teck

> Plancher entier en teck. Avant, 
cockpit, et plateforme de bain
> Tableau arrière convertible en 
bain de soleil
> Lumière à l’ouverture-cabine et salon
> T.V. - écran plat / DVD - Salon
> T.V. - écran plat / DVD - cabine 
avant
> Table en V convertible en 
couchage
> Deux Chart plotter/Ecran 
digitaux 9” avec Radar Quantum
> 4G Radar
> Inverter 12V
> Stereo Premium upgrade dans 
cockpit et cabin
> Radio VHF avec antenne
> Climatisation réversible 220v/50 
(cabine seule)
> Climatisation réversible 220v/50 
dans cabin et cockpit
> Porte Pavillon
> Generateur - essence - 
220v/50HZ 
>Generateur - Diesel - 220v/50HZ 
> Chauffage cabine - diesel

IOPCIONES INDIVIDUALES
> Pintura de fondos
> De proa
> Luces de atraque
> Plataforma de Baño Sumergible 
Automática
> Luces sumergidas, del casco
> Faro Pirata - 5´ control remoto
> Molinete con Cadena y con ancla acero.
> Hard top de fibra 
> Techo Rígido con Toldo Aperturable
> Extensión Sombrilla
> Toldos Camper (Con arco o open)
> Toldos Camper con Hard Top
> Lona de fondeo
> Toldo de sol en proa
> Mesa en proa con almacenamiento
> Cocina en Bañera Alcohol o - 2 
fuegos 
> Mesa en bañera en teka - conver-
tible a solarium
> Clips para Defensas
> Barbacoa en Bañera
> Infinity, Woven Cockpit Flooring
> Conjunto Luces Led en Bañera: 
Azul o blanca
> Nevera en bañera - 12v

> SeaDek en Plataforma de Baño: 
Gris o mocha
> Teca en plataforma de baño
> Suelo de Teca - Bañera y & 
Plataforma de Baño
> Asientos en colchoneta de Popa
> Ojo de Buey - con Apertura - 1 
Cocina  & Salon
> T .V. - c/ DVD - Salon 
> T.V. - c/ DVD - Camarote de Proa 
> Mesa ajustable en cabina V-Berth
> Cuadro Digital (Pantalla 9” con 
Radar Quantum)
> Inversor - 12V a 220V/50
> Estéreo Premier -  Cabina & Bañera
> Radio VHF Radio - c/ Antena
> Aire Acondicionado Frio/ Calor, 
solo en cabina
> Aire Acondicionado Frio/ Calor, 
Cabina y Bañera- 220V/50
> Mastil Bandera
> Generador - Gasolina - 
220v/50HZ 
> Generador - Diesel - 220v/50HZ 
> Cabina Webasto para diesel

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Bugschraube
> Docking Lights (Leuchten im Bug)
> Automatische Unterwasserplattform
> Unterwasserbeleuchtung durch 
den Rumpf
> Suchscheinwerfer
elektrische Ankerwinde mit Kette 
und Edelstahlanker
> Hardtop aus GfK
> Lukenausschnitt (Verdeckein-
lass) für Hardtop
verlängertes Bimini-Top für 
Hardtopversion
> Camperverdeckpaket
> Camperverdeckpaket
> Sportpersenning
> Beschattung Vorderdeck
> Cockpittisch im Bug mit 
Verstaumöglichkeit
> Cockpitkocher (Spititus und/oder 
elektrisch)
> Sitzgruppe achtern mit Cockpit-
tisch / Sonnenliege
> Fenderclipse
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Grill 220V im Cockpit

> Blaues oder weißes LED-Licht-
paket
> Kühlschrank im Cockpit (12 V)
Seadek Belag auf der Badeplattform
> Teakboden auf der Badeplattform
> Teakboden im Cockpit und auf 
der Badeplattform
> Transom Sonnenliege
> Bullauge zum Öffnen in der 
Küche und Salon
> LED-Fernseher / DVD-Kombination Salon
> LED-Fernseher / DVD-Kombina-
tion Bugkabine
> Höhenverstellbarer Tischfuß 
Bugkabine
> Digitales Armaturenbrett mit 9” 
Plotter und Radar
> Inverter 12V/220V
> Premium Stereosystem mit 
Subwoofer
> Funkgerät mit Antenne
> Klimaanlage / Heizung Kabine 220 V
> Klimaanlage / Heizung Kabine 
und Cockpit 220 V
> Flaggstock
> Generator Kohler, 4.0 KW EFCD; Benzin
> Generator Kohler, 3,5 KW EFOZ; Diesel
> Heizung Webasto (Diesel) für 
Kabine

9,85 M | 3,25 M 643 L 6.500 KG

FEATURES & STANDARD EQUIPMENT
>	Twin MerCruiser® ECT 4.5 MPI DTS Bravo III Sterndrive (250 hp - 188 kW)
> 	Cockpit Galley with Refrigerator & Stove w/Corian® Countertop, Teak
> 	Compass 
> 	Docking Lights
>	Dual Battery Switch & Shore Power w/ Battery Charger
>	Enclosed Forward Cabin with large bed.
>	Enclosed Mid-Cabin with large double bed
> 	Freshwater Washdown Spigot
>	Good Walk-Around capability on deck
>	�Luxury Wallnut wood finish inside the cabin with Shoji doors and solid 

wood frames.
>	Separated Enclosed Shower Cabin with door
> 	Shower, Cockpit-Cabin Hot & Cold
> 	Standard fiberglass arch w/Bimini & enclosures
> 	Stereo, 12V FM with MP3 / USB Port,
	 iPod® Connection, Weatherproof Speakers & Digital Cockpit Remote
> 	Swim Platform, Extended w/Concealed Stainless Steel Swim Ladder
> 	Trim Tabs, Electric
> 	Teak Table w/Sun Pad Filler Cushions
> 	Water Heater, 220V (22 liter) w/Exchanger
> 	Windshield Wipers with fresh water flush
>	Wood Salon Flooring
> CE Fire Suppression System - automatic w/manual pull
>	Electrical Toilet with macerator 

CARACTÉRISTIQUES & ÉQUIPEMENTS DE SÉRIE
>	Moteurs jumelés MerCruiser® 4.5 MPI DTS Bravo III (T250 ch - 188 kW)
>	�Cuisine dans le cockpit avec réfrigérateur et cuisinière avec comptoir 

Corian®, en teck
>	Compas
>	Feux d’amarrage
>	�Commutateur de sélection de batterie et prise d’alimentation  

avec chargeur de batterie
>	Cabine avant fermée avec grand lit
>	Cabine centrale fermée avec grand lit double
>	Robinet de rinçage à l’eau douce
>	Bonne capacité de déplacement sur le pont
>	�Finition noyer de luxe à l’intérieur de la cabine avec portes Shoji  

et cadres en bois solides
>	Cabine de douche fermée séparée avec porte
>	Douche dans le cockpit-cabine avec eau chaude et froide
>	Arche en fibre de verre avec bâche Bimini et protection de série
>	�Combiné radio, FM 12V, port MP3/USB, connexion iPod®, haut-parleurs 

résistants aux intempéries & télécommande digitale  
dans le cockpit

>	Plate-forme de bain avec échelle de bain en acier inoxydable dissimulée
>	Régulateurs d’assiette électriques
>	Table en teck et coussins amovibles pour bain de soleil
>	Chauffe-eau 220 V (22 litres) avec échangeur
>	Essuie-glaces avec rinçage à l’eau douce
> Système de lutte incendie CE automatisé avec déclenchement manuel
>	Plancher du salon en bois

CARACTERÍSTICAS Y EQUIPO ESTÁNDAR
>	Motores de popa dobles MerCruiser® 4,5 l MPI DTS Bravo III (250 hp - 188 kW)
>	Cocina en la bañera con frigorífico y fogón con encimera Corian®, teca
>	Brújula
>	Luces de atraque
>	�Interruptor de baterías dual y toma de alimentación del muelle  

con cargador para baterías
>	Cabina frontal independiente con cama de grandes dimensiones
>	�Cabina central independiente con cama de matrimonio  

de grandes dimensiones
>	Grifo de lavado con agua dulce
>	Buen paso de acceso (walkaround) en cubierta
>	�Sofisticado acabado en nogal dentro de la cabina con puertas shoji  

y marcos de madera maciza.
>	Cabina de ducha independiente con puerta
>	Ducha, bañera, agua fría y caliente
>	Arco en fibra de vidrio estándar con Bimini y entoldados
>	�Equipo estereofónico FM de con puerto MP3/USB,  

conector para iPod®, altavoces a prueba de intemperie y mando  
a distancia digital desde la bañera

>	Plataforma de baño extendida con escalera oculta de acero inoxidable
>	Aletas de compensación hidráulica
>	Mesa de teca con colchonetas de extensión para el solárium
>	Calentador de agua, 220V (22 l) con intercambiador
>	Limpiaparabrisas con agua dulce para lavado
> Sistema EC de extinción de incendios - automático con bomba manual
>	Suelo de madera en el salón

LEISTUNGSMERKMALE UND STANDARDAUSRÜSTUNG
>	Twin MerCruiser® 4,5 l MPI DTS Bravo III Heckantriebe (250 PS - 188 kW)
>	Kombüse im Cockpit mit Spüle, Herd mit Corian®-Arbeitsplatte, Teak
>	Kompass
>	Anlegelichter
>	Batterieschalter, dual & Hafenstrom mit Batterieladegerät
>	Geschlossene Vorderkabine mit großem Bett
>	Geschlossene Mittelkabine mit großem Doppelbett
>	Frischwasser-Abspritzsystem
>	Rundum gut begehbares Deck
>	�Innenausstattung der Kabine in exklusivem Nussbaum,  

mit Shoji-Türen und soliden Holzrahmen
>	Abgeschlossene Duschkabine mit Tür
>	Dusche, Cockpit - Kabine, heißes und kaltes Wasser
>	Serienmäßiger GfK-Radarbügel mit Bimini-Verdeck & Abdeckungen
>	�Stereoanlage, 12V FM mit MP3-/USB-Eingang, iPod®-Anschluss, 4 

wasserdichten Lautsprechern und digitaler Cockpit-Fernbedienung
>	Badeplattform, mit eingelassener Badeleiter aus Edelstahl
>	Elektrische Trimmklappen
>	Tisch im Cockpit aus massivem Teakholz und Füllkissen für die Sonnenliege
>	Warmwasserspeicher 220V (22 Liter) mit Wärmeaustauscher
>	Scheibenwischer mit Frischwasserspülung
> CE-Feuerlöschsystem - automatisch mit manuellem Zug
>	Holzbodenbelag im Salon

INDIVIDUAL OPTIONS
> Bottom Paint
> Bow Thruster 
> Fordeck Sun Pad 
> Windlass - Electric with Chain & 
SST Anchor
> Hardtop with Aft Canvas & 
Cockpit Heat - Engine
> Camper Canvas Package ( for 
boat with arch or open )
> Camper Canvas Package With 
Hardtop
> Canvas Cockpit Cover
> Cockpit Heater from engine
> Infinity, Woven Cockpit Flooring 
> Teak Cockpit Upgrade 
> Teak On Swim Platform
> Cabin Galley with Corian counter-
top, Sink and Refrigerator
> Cabin Galley Stove 
> Microwave - 220v/50
T.V. - Flat Screen w/ DVD - Salon 
- 220v/50

T.V. - Flat Screen w/ DVD - 
Mid-Stateroom - 220v/50
> Digital Dash w/ Merc Vesselview 
Link 9”
> Air Conditioning / Heating - 
220v/50 (Cabin Only)
> Cockpit Heater w/heat from engine 
> Generator - Gas - 220v/50HZ 
> Generator - Diesel - 220v/50HZ 
> Webasto Cabin and Cockpit 
> Heating - Diesel

OPTIONS INDIVIDUELLES
> Antifouling usine
> Propulseur d’étrave
> Bain de soleil avant avec mains 
courantes
> Guindeau éléctrique avec chaîne 
et ancre inox
> Hardtop avec taud arrière et 
chauffage cockpit - alimentation 
moteur
> Package taud Camper (pour 
bateau avec arceau ou open)
> Package taud Camper avec 
hardtop
> Taud de cockpit
> Chauffage de cockpit de la calle 
moteur
> Moquette fine infinity
> Cockpit recouvert de teck ( 
Remplace les moquettes)
> Extension de plateforme de bain 
recouverte de teck
> Cuisine en Corian dans la cabine 
avec évier et réfrigérateur
> Rechaud dans la cabine

> Micro-ondes 220v/50
> T.V. - écran plat / DVD - Salon - 
220v/50
> T.V. - écran plat / DVD -  - 220v/50 
cabine avant
> Ecran digital 9”
> Climatisation réversible 220v/50 
(cabine seule)
> Chauffage de cockpit- 
alimentation moteur 
> Generateur - essence - 
220v/50HZ 
> Generateur - Diesel - 220v/50HZ 
> Chauffage cabine et cockpit - 
diesel

OPCIONES INDIVIDUALES
> Pintura de fondos
> De proa
> Colchoneta de proa
> Molinete con Cadena y con ancla 
acero inox.
> Hard Top con toldo de popa y 
calefacccion
> Toldos Camper (Con arco o open)
> Toldos Camper con Hard Top
> Lona de fondeo
> Infinity, Woven Cockpit Flooring
> Mejoras de teca
> Teca en plataforma de baño
> Zona cocina interior con nevera, 
lavabo y encimera Corian
> Horno en cabina
> Microondas 220v/50
> T.V. - c/ DVD - Salon - 220v/50
> T.V. - c/ DVD - Camarote de Proa 
- 220v/50
> Cuadro Digital (Pantalla 9”)

> Aire Acondicionado Frio/ Calor, 
solo en cabina
> Bañera de motores
> Generador - Gasolina - 220v/50HZ 
> Generador - Diesel - 220v/50HZ 
> Cabina y bañera Webasto para 
diesel

KUNDENSPEZIFISCHE OPTIONEN
> Antifouling
> Bugschraube
> Sonnenliege auf dem Vorderdeck
> Elektrische Ankerwinde mit Kette 
und Edelstahlanker
> Hardtop mit Heckverdeck und 
Cockpitheizung über den Motor
> Camperverdeckpaket
> Camperverdeckpaket
> Sportpersenning
>Cockpitheizung über den Motor
> Infinity Cockpit Bodenbelag, 
gewebtes Kunstleder
> Teakboden im Cockpit
> Teakboden auf der Badeplattform
> Kabinenküche mit Corian-
Arbeitsfläche, Spüle und 
Kühlschrank
> Kocher in der Kabine
> Mikrowelle 220 V
> LED-Fernseher / DVD-
Kombination Salon
> LED-Fernseher / DVD-
Kombination Bugkabine

> Digitales Armaturenbrett mit 
9” Plotter
> Klimaanlage / Heizung Kabine 
220 V
> Cockpitheizung über den Motor
> Generator Kohler, 4.0 KW EFCD; 
Benzin
> Generator Kohler, 3,5 KW EFOZ; 
Diesel
> Heizung Webasto (Diesel) 
für Kabine und Cockpit 

S E A  R A Y 
S U N D A N C E R ®  3 5 5 12P / 1360 KG 6P 11,2 M | 3,84 M

OPTIONS & ACCESSORIES
OPTIONAL ENGINES
>	� Twin Mercruiser ECT 6.2 MPI Bravo III w/DTS Sterndrive (300 hp - 224 kW)
>	� Twin MerCruiser® Diesel TDI® 3.0L 265 HO Bravo® IIIx (265 hp - 198 kW)
>	� non ECT Engines available outside EU
Axius available on above engine options

OPTIONS & ACCESSOIRES
MOTEURS OPTIONNELS
>	�Moteurs jumelés MerCruiser 6.2L MPI Bravo III avec DTS (300 ch - 224 kW)
>	�Moteurs jumelés diesel TDI® MerCruiser® 3.0L 265 HO Bravo® IIIx 

(265 ch - 198 kW)
>	Moteurs non-ECT disponibles en dehors de l’UE

OPCIONES Y ACCESORIOS
MOTORES OPCIONALES
>	�Motores de popa dobles MerCruiser 6,2L MPI Bravo III con DTS (300 hp - 224 kW)
>	�MerCruiser® Diesel dobles TDI® 3,0L 265 HO Bravo® IIIx (265 hp - 198 kW)
>	Motores sin ECT disponibles fuera de la UE

OPTIONEN UND ZUBEHÖR
OPTIONEN FÜR MOTOREN
>	�Twin MerCruiser 6,2 l MPI Bravo III mit DTS Heckantrieb (300 PS - 224 kW)
>	�Twin MerCruiser® Diesel TDI® 3,0 l 265 HO Bravo® IIIx (265 PS - 198 kW)
>	Nicht-ETC-Motoren außerhalb der EU verfügbar

760 L 6.900 KG4P 
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In addition to the premium Models in the catalog 
Sea Ray® offers the following truly world-class 
Sport Boats, Cruisers & Yachts. Build in the USA

Outre les magnifiques modèles du catalogue,  
Sea Ray® vous propose les Sport Boats, Cruisers  
et Yachts suivants.

Además de los modelos premium del catálogo,  
Sea Ray® ofrece las siguientes embarcaciones 
deportivas, cruceros y yates.

Zusätzlich zu den in diesem Katalog abgebildeten 
Premium-Modellen bietet Sea Ray® Sportboote, 
Sport-Cruiser und Yachten der Weltklasse.

T H E  S E A  R A Y ®  L I N E U P

S E A  R AY  S P X  1 9 0  
S E A  R AY  S P X  1 9 0  O B 
S E A  R AY  S P X  2 1 0 
S E A  R AY  S P X  2 1 0  O B
S E A  R AY  S P X  2 3 0  
S E A  R AY  S P X  2 3 0  O B

S E A  R AY  S U N D A N C E R  2 6 0 
S E A  R AY  S U N D A N C E R  3 2 0 
S E A  R AY  S U N D A N C E R  3 2 0  O B
S E A  R AY  S U N D A N C E R  3 5 0  
S E A  R AY  S U N D A N C E R  3 5 0  C O U P E

S E A  R AY  S L X  2 3 0 
S E A  R AY  S L X- W  2 3 0
S E A  R AY  S L X  2 5 0 
S E A  R AY  S L X  2 8 0
S E A  R AY  S L X  3 1 0 
S E A  R AY  S L X  3 1 0  O B
S E A  R AY  S L X  3 5 0
S E A  R AY  S L X  3 5 0  O B
S E A  R AY  S L X  4 0 0
S E A  R AY  S L X  4 0 0  O B

S E A  R AY  S U N D A N C E R  4 0 0
S E A  R AY  S U N D A N C E R  F LY  4 0 0 
S E A  R AY  S U N D A N C E R  4 6 0
S E A  R AY  S U N D A N C E R  F LY  4 6 0
S E A  R AY  S U N D A N C E R  5 1 0  
S E A  R AY  S U N D A N C E R  F LY  5 1 0
S E A  R AY  S U N D A N C E R  5 1 0 
	     S I G N AT U R E 
S E A  R AY  S U N D A N C E R  5 2 0
S E A  R AY  S U N D A N C E R  F LY  5 2 0

S E A  R AY  L 5 5 0
S E A  R AY  L 5 5 0  F LY
S E A  R AY  L 5 9 0  
S E A  R AY  L 5 9 0  F LY
S E A  R AY  L 6 5 0 
S E A  R AY  L 6 5 0  F LY

S E A  R AY  S D X  2 5 0 
S E A  R AY  S D X  2 5 0  O B  
S E A  R AY  S D X  2 7 0  
S E A  R AY  S D X  2 7 0  O B
S E A  R AY  S D X  2 9 0  
S E A  R AY  S D X  2 9 0  O B  
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sea ray headquarters 
800 S. Gay St.
Suite 1200
Knoxville
TN 37929, USA 
phone: +1 (865) 582-2200 
www.sea ray.com

note: not all accessories shown in pictures or described herein are 
standard equipment or even available as options. options and 

features are subject to change without notice. not all model year 
boats may contain all the features or meet the specifications 

described herein. confirm availability of all accessories and 
equipment with an authorized sea ray dealer prior to purchase.

printed in the netherlands 2017 © sea ray boats.

tous les accéssoires présentés sont livrés de série ou disponibles 
en option. options et spécificités peuvent être amenés à changer 

sans préavis. les équipements peuvent changer en fonction du 
millésime. imprimé en hollande août 2017 © sea ray.

nota: no todos los accesorios que se muestran en las imágenes 
o se describen en el texto son equipamientos estándar o están 

disponibles opcionalmente. las opciones y características 
pueden cambiar sin previo aviso. no todas las embarcaciones 

de un modelo y año completos reúnen todas las características 
ni cumplen las especificaciones aquí descritas. confirme la 
disponibilidad y el equipamiento con un proveedor sea ray 

autorizado antes de comprar el barco. impreso en estados unidos.
2017 © sea ray boats.

hinweis: nicht alle auf den dargestellten oder in der broschüre 
beschriebenen zubehörteile gehören zur standardausrüstung oder 

sind überhaupt als option verfügbar. änderungen zu optionen 
und eigenschaften ohne vorankündigung vorbehalten. nicht alle 

bootsmodelle eines jahres enthalten alle eigenschaften oder 
entsprechenden in dieser broschüre dargestellten technischen 
angaben. erkundigen sie sich bei einem zugelassenen sea ray 

händler vor dem verkauf nach der verfügbarkeit und austattung. 
gedruckt in den nierlanden 2017 © sea ray boats.

europe, middle east & africa office:
brunswick netherlands
Oude Haagseweg 47
1066 BV Amsterdam
The Netherlands 
phone: +31 (20) 511-0011
amsterdam@brunswick.com

DEFINE YOUR LIFE WITH
THE MOMENTS THAT COUNT
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